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Preface  
 

This manual provides installation, setup and operating instructions for 360 Systems’  
MAXX-2420-EX video server.  It is organized to provide quick access to topics of primary interest.  
An extensive Table of Contents is provided at the beginning, and a subject Index at the end, to 
assist in locating information. 

If you have already used other video servers or VTRs, you may find discussion of the basic 
server to be covering familiar topics.  However, it is strongly recommended that engineering 
managers and staff members operating the server read through this manual.  Being familiar with its 
operation can prevent operational mistakes, and will make all users aware of important set-up and 
maintenance issues.  

Software and Operations Manual Revisions 
Software revisions are released from time-to-time that introduce new product features, or 

improve the performance of the product.  When such revisions are shipped as a USB flash drive, 
printed operational notes are included.  When revisions are introduced in the course of product 
production, an updated Operations Manual will be shipped with new servers.   

The title page of an Operations Manual indicates its revision number, which should always 
match the software revision of the server with which it is used.  Operations Manuals for the latest 
revision may be obtained from 360 Systems Customer Service, or from 360 Systems’ web site.  

Your comments are welcome.  If anything in this manual seems unclear, please let us know by 
sending an email to support@360systems.com.  

 

Typographical Conventions 
The following typographical conventions are used to clarify meaning: 

• Connector or indicator labeling that appears on the unit is shown in Arial Narrow Bold. 
• GUI menu items are shown in Arial Bold. 
• GUI sub-menu paths are shown by the > symbol. 
• Text typed into the GUI and Key Commands are shown in Courier Bold. 
 
 



 

Page 10 MAXX-2420-EX Owner’s Manual 

Safety Notices 

Safety Terms and Symbols 

THE FOLLOWING WARNING SYMBOLS ARE USED IN THIS MANUAL: 

ENGLISH ATTENTION:  REFER TO OWNER’S MANUAL FOR IMPORTANT 
INFORMATION. 

FRANÇAIS ATTENTION:  VEUILLEZ VOUS RÉFÉRER AU MODE D’EMPLOI 
POUR UNE INFORMATION IMPORTANTE. 

ITALIANO ATTENZIONE:  FATE RIFERIMENTO AL MANUALE PER 
INFORMAZIONI IMPORTANTI. 

 

ESPAÑOL ATENTCION:  FAVOR DE REFERIR AL MANUAL DE 
OPERACION POR INFORMACION IMPORTANTE. 

 
ENGLISH WARNING:  ELECTRICAL SHOCK HAZARD. 
FRANÇAIS AVERTISSEMENT:  DANGER DE CHOC ÉLECTRIQUE. 
ITALIANO AVVERTIMENTO:  PERICOLO DI SHOCK ELETTRICO. 

 

ESPAÑOL ADVERTENSIA:  PELIGRO DE CHOQUE ELECTRICO. 

General Safety Caution 
• Heed the following important cautions regarding the server in order to avoid personal injury or 

equipment damage. 

• Only qualified personnel should perform installation and service.  Refer to appropriate sections 
of this product manual for instruction.  Contact 360 Systems Customer Support for further 
explanation, or to clarify any uncertainty. 

• Disconnect the power cord before removing the cover. 

Personal Injury Precautions 
To avoid electric shock, do not operate this product with covers removed. 

To avoid risk of fire, replace the power cord only with same type and rating as specified.  Replace 
damaged power cords immediately. 

This product is grounded through the grounding conductor of the power cord.  To avoid electric 
shock, do not remove or modify the contacts on the plug. 

Prevent the power cord from being walked on, pinched, or abraded. 

To reduce the risk of fire or electric shock, do not expose this unit to rain or moisture. 

Remove jewelry such as watches or metallic necklaces before servicing this equipment. 
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Important Safety Instructions 
These instructions are required per applicable safety standards. 

1. Read these instructions. 

2. Keep these instructions. 

3. Heed all warnings. 

4. Follow all instructions. 

5. Do not use this apparatus near water. 

6. Clean only with dry cloth. 

7. Do not block any ventilation openings. Install in accordance with the 
manufacturer’s instructions. 

8. Do not install near any heat sources such as radiators, heat registers, stoves, or 
other apparatus (including amplifiers) that produce heat. 

9. Do not defeat the safety purpose of the polarized or grounding-type plug. A 
polarized plug has two blades with one wider than the other. A grounding type 
plug has two blades and a third grounding prong. The wide blade or the third 
prong are provided for your safety. If the provided plug does not fit into your 
outlet, consult an electrician for replacement of the obsolete outlet. 

10. Protect the power cord from being walked on or pinched particularly at plugs, 
convenience receptacles, and the point where they exit from the apparatus. 

11. Only use attachments/accessories specified by the manufacturer. 

12. Unplug this apparatus during lightning storms or when unused for long periods of 
time. 

13. Refer all servicing to qualified service personnel. Servicing is required when the 
apparatus has been damaged in any way, such as power-supply cord or plug is 
damaged, liquid has been spilled or objects have fallen into the apparatus, the 
apparatus has been exposed to rain or moisture, does not operate normally, or has 
been dropped.  

14. Where the MAINS plug or an appliance coupler is used as the disconnect device, 
the disconnect device shall remain readily operable. 
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Product Damage Precautions 
• 360 Systems’ MAXX-2420-EX™ server contains hard disk drives and other fragile electronic and 

mechanical devices.  While designed to be very reliable, it is still vulnerable to shock.  Handle 
with care, and exercise caution not to drop or bump the server as damage to internal 
components may result.  Always turn off power before moving the server. 

• Do not obstruct air vents.  Maintain an ambient temperature below 30°C (86°F). 

• Clean only with a soft cloth dampened with water.  Do not spray cleaners or solvents directly 
on the product. 

 CAUTION: 

Replace the motherboard battery only with the same, or equivalent battery type.  Danger 
of explosion if battery is incorrectly replaced. Replace only with the same or equivalent 
type recommended by the equipment manufacturer. Discard used batteries according to 
manufacturer’s instructions.  Follow all local laws regarding the disposal of BR and CR 
Lithium batteries.  Batteries should be fully discharged prior to disposal. 

 CAUTION: 

Never use disconnect AC power to shutdown the server.  Doing so may cause errors in 
the hard disk array.  Should this happen, the array can be reinitialized without any data 
loss; however, the process may take several hours.  Shutdown the system only by 
momentarily pressing the front panel power button, or through the On-Screen user 
interface. 

Product Registration 
Important: As the owner of new capital equipment, you will want to take advantage of product 
information, enhancements, upgrades, or notifications issued by 360 Systems.  Send in your 
Warranty Card so 360 Systems can remain in contact with you.  Mail or fax it to 360 Systems 
offices in the USA at the address given below. 

Product Improvements and Upgrades 
360 Systems reserves the right to make changes and/or improvements to its products without 
incurring any obligation to incorporate such changes or improvements in units previously sold.  
Certain features mentioned in this document may not be present in all models.  This product is 
not offered for sale in all countries. 

Trademarks 
MAXX, Image Server, Multi-Format server, 360 Systems®, 360 Systems Broadcast and Bit-for-
Bit® are trademarks or registered trademarks of 360 Systems in the U.S. and/or foreign 
countries.  Other trademarks referred to in this document are the property of their respective 
owners. 

Software Copyrights 
Software in this product is based on the work of, or is copyright by, 360 Systems, SuSE® 
GmbH, Trolltech, and FreeType Team.  Copyright 2003-2009 by 360 Systems. 

Video and Audio Copyright Reminder 
It is illegal to use this product to make copies of copyrighted material without the express 
permission of the copyright holder. 
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Introduction 
 

360 Systems’ MAXX-2420™ server is a four channel, high-definition video recorder/server 
designed for broadcast, production, and Pro A/V applications.  It can play four independent video 
streams at once, and stores approximately 330 hours of JPEG-2000 encoded video1 with eight 

audio channels per video stream.  It occupies just 3½” of rack space.  The server’s extensive feature 
set makes it an excellent choice for VTR replacement, broadcast automation, remote trucks, 
corporate, educational, house-of-worship, and live entertainment presentations.  MAXX-2420-EX 
can be operated at high definition line rates of 720p or 1080i.    

Seamless Installation in New Facilities  
The MAXX-2420-EX smoothes installation in a new setting, providing both HD-SDI video and 

optional composite monitoring outputs. Program file transfers are also available over Gigabit 
Ethernet. It’s never necessary to add outboard encoders; premium-quality JPEG-2000 codecs are 
included as standard equipment.   

All professional audio formats are available with MAXX-2420-EX. Eight channels of embedded 
audio for each video input and output are included. Optional multi-channel audio modules 
provide 8 channels of AES/EBU digital audio interface (Model DXP-1), and either 4 or 8 channels of 
+4 balanced analog audio (Model AXP-3 and AXP-4). 

MAXX-2420-EX’s versatile video and audio I /O personality is unique among HD servers, and 
guarantees a seamless fit in existing facilities, and as part of new build-outs. 

Exceptional Storage Capacity  
The MAXX-2420-EX contains eight 1- or 2-Terabyte drives in its compact enclosure, providing 

hundreds of hours of storage with exceptional image quality.  Storage time varies proportionally at 
other data rates, as illustrated in the chart below.  

The server’s RAID-5 disk array provides a high level of security for stored program content, by 
spreading parity information across all drives. It also helps keep the server in service, even in the 
event a drive was to fail.  The multi-drive array also helps generate the data rates required for 
multiple streams of high definition video. 

 
Capacity, net of RAID-5 Time @ 50 Mb/s Time @ 80 Mb/s Time @ 100 Mb/s 

7.0 TB (1 TB drives) 250 hours 165 hours 135 hours 

14.0 TB (2 TB drives) 500 hours 330 hours 270 hours 

MAXX-2420-EX STORAGE TIME VS VIDEO DATA RATE 

                                                 
1 At 80 Mb/sec data rate 
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Compatibility with Automation Controllers  
MAXX servers work with automation controllers from many different manufacturers, accepting 

VDCP, Odetics or BVW protocols for 9-pin control of each server channel.  360 Systems’ business 
partners provide automation controllers for applications ranging from affordable systems for Pro-
AV, up to large-scale broadcast solutions. Contact a 360 Systems application engineer or an 
automation provider for assistance with your requirements. 

Remote Controls 
Hardware accessories are available from third-party manufacturers to perform transport 

control, instant clip replay, slow-mo, and automation.  A table of tested controllers is provided 
elsewhere in this manual. Contact 360 Systems Sales Support team for assistance with a specific 
application. 

The MAXX-2420-EX server provides twelve GPI inputs for remote play, stop, and record 
capability from push-button panels or other GPI-controlled equipment.  Twelve outputs are also 
provided; these may be used for command acknowledgement (to drive LEDs or logic inputs), or 
they can output at specific times programmed within a Playlist that is resident on the server. 

Better Images with JPEG 2000  
JPEG-2000 has distinguished itself for visually lossless encoding of images, and almost 

complete freedom from visual artifacts. It sets a new level of image quality for High Definition, 
well-suited for production and broadcast. It’s a first choice for many new cameras and servers, and 
its easy-to-edit I-frame format is accepted by an increasing number of NLEs. The MAXX-2420-EX 
runs at a wide range of video rates, making it an excellent choice for production, broadcast, and 
even high-quality projection. 

Audio Features 
MAXX-2420-EX provides most standard professional audio formats, making it an easy fit in a 

new facility. Eight embedded audio channels are standard equipment for each video stream. 
Analog audio is expandable to 4 analog channels with the AXP-3 module, and up to 8 analog 
channels with the addition of an AXP-4 module. Eight channels of AES/EBU digital audio are 
alternatively available with the optional DXP-1 module. Gold XLR connectors are standard for 
audio inputs and outputs.   

360 Systems brings extensive experience in broadcast and pro-audio to the design of video 
servers.  Their 24-bit word size delivers a 20 dB improvement in SNR (10 times) compared with 
older 16-bit audio systems.   Input circuits provide excellent hum and RF rejection, and 20 dB of 
headroom.  360 Systems’ Bit-for-Bit® design strategy assures that Dolby®-E, Dolby AC3, or other 
forms of encoded audio will be stored and played correctly. 

The Graphic User Interface 
The MAXX-2420-EX incorporates a graphic user interface (GUI) which gives fast access to 

every server function. It is controlled by a standard keyboard and mouse (supplied) and requires 
only a VESA-compliant SVGA display. The full GUI is also available from remote workstations. 

The GUI displays a control panel for each server channel; these include transport control, clip 
management, head and tail trimming, and playlisting.  The GUI can easily operate the server’s four 
channels without the need for other equipment. 
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System configuration is clear and straightforward through the GUI.  It provides access to 
encoding parameters, audio options, and time-code settings.  Whenever new server features are 
installed, new set-up parameters and user-interface features become immediately available. 

The server comes with Remote Workstation Software, which allows it to be remotely operated 
from a standard PC over Ethernet; the GUI is replicated at each remote location. Separate work 
areas can be easily created within a building for ingest, trimming, playlisting, system monitoring or 
play-to-air.  

File Transfers over Gigabit Ethernet 
The MAXX-2420-EX goes beyond just base-band connections for video and audio.  File 

transfers over Gigabit Ethernet allow the transfer of video content across the room, or across the 
country, at high speed and low cost. With Ethernet switches and broadband connections, the 
server’s design enables low-cost networking of broadcast operations from ingest to storage, for 
editing, play-to-air and archiving. 

Reliability Counts 
360 Systems has 39 years experience manufacturing equipment for television broadcast and 

other industries that require elevated reliability.  With more than 30,000 hard disk products in 
service around the world, we understand quality, reliability, and protecting your stored content.   
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Key Features and Benefits 
The MAXX-2420-EX is designed from the ground up to deliver outstanding performance and 

value as a high-definition broadcast server.  Two inputs, four outputs, a Gigabit Ethernet port, and 
multiple audio formats make it an excellent and affordable choice for the transition to high 
definition. 
  

 Four simultaneous video outputs, one input and three outputs, or two inputs and two outputs 

 HD-SDI video inputs and outputs 

 Optional Composite video monitoring outputs  

 Eight channels of embedded audio (standard) 

 Optional 4 channel analog audio input/output expander available (AXP-3, Channels 1-4)  

 Optional 4 channel analog audio input/output expander available (AXP-4, Channels 5-8*) 

 Optional 8 channel AES/EBU digital audio expander available (DXP-1) 

 16 Terabyte internal RAID-5 drive array for 330 hours of storage 

 Slow-Motion playback forward and reverse 
 Ganged playback of paired Key-and-Fill or 3D video.Targa file import via Ethernet 

 Serial control via VDCP, BVW or Odetics protocols 

 Compatible with leading broadcast automation systems 

 FTP transfers over Gigabit Ethernet  

 VITC (ATC) time code  

 Closed-Captions and other Vertical Ancillary Data 

 Accurate head and tail trimming and program segmenting 

 Advanced Playlisting: Build, edit, store, playback, and loop 4 simultaneous lists 

 Looping 

 Keyboard shortcuts for editing  

 Set-up and control with familiar Graphic User Interface (GUI) 

 Remote Workstation Software creates up to four remote worksites  

 Compact 2-RU (3½”) [88 mm] enclosure, low power consumption 

 Redundant cooling and optional hot swap capable power supplies 

 Attractively priced 

                                                 
* AXP-4 requires AXP-3. 
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Applications for 360 Systems Servers 
The MAXX-2420-EX adds value to many applications in broadcasting, cable distribution, video 

production, Pro A/V, entertainment and sports.  It provides immediate record and playback of any 
source, lending a spontaneous appearance to broadcasts, presentations and live events. 
 

• News Production – Promos, teasers, intros, news segments, graphics, animation 

• Play-to-Air server – Playback under automation control 

• Graphics server – Play TARGA files with key-and-fill (available Q2-2009) 

• Master Control – Program and commercial playout, station IDs, promos, teasers 

• Program Ingest – Automated capture of satellite, tape, microwave, and fiber feeds 

• FTP File Delivery – Deliver news, promos, spots over broadband lines 

• Program Store-and-Forward – Temporary storage for subsequent delivery  

• Commercial Insertion – Playout under automation control 

• Instant Replay – Hot Key playback of sports plays, news clips, stills, and graphics 

• Sports Shows and Events – Slow-motion playback, player bios, graphics, promos  

• Game Shows – Prizes, graphics, animations, promos 

• Talk and Variety Shows – Promos, teasers, intros, outros, graphics, animations 

• Award Shows – Nominees, categories, promos, graphics, animations 

• Theme Parks and Casinos – Playout for show backgrounds, event lists, kiosks 

• Houses of Worship --  Projection displays, program production, broadcasting 

• Colleges and Universities – On-campus networks, production, presentations 

• Digital Signage – drive projectors, flat-panel displays, kiosks 

• Entertainment Industry – Road show displays, projection 

• Mid-market Broadcasting – High performance at an attractive price 

• Synchronized two-channel playback for 3D video 

• Synchronize 3 or 4 channels for multi-screen presentations and “virtual set” applications 
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Accessory Information 
 
 

AXP-3 Multi-Channel Analog Audio Module (optional – provides audio channels 1-4) 
Provides 4 analog audio outputs for each of 4 server video outputs, and 4 analog audio inputs. 
+4 dBu balanced on XLR connectors. Redundant power supply. 3½” [88 mm] height. 

AXP-4 Multi-Channel Analog Audio Module (optional– provides audio channels 5-8) 
Provides 4 analog audio outputs for each of 4 server video outputs, and 4 analog audio inputs. 
+4 dBu balanced on XLR connectors. Redundant power supply. 3½” [88 mm] height. 
Requires AXP-3. 

DXP-1 Multi-Channel Digital Audio Module (optional) 
Provides 8 AES/EBU digital audio outputs for each of 4 video streams, and 8 AES/EBU inputs on 
XLR connectors. Redundant power supply. 3½” [88 mm] height.  
 
 

Maintenance Spares  
360 Systems is committed to keeping your server on air.  Having spare parts on hand in the 
event of a fault is a good practice in broadcast and other high-reliability applications.  Hard 
disk spares are particularly important. Please consider these options at the time of your 
purchase, or shortly after. 

• 1-TB or 2-TB server-grade hard drive  

• MAXX-2420-EX plug-in power supply module  
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Installation 

Unpacking 
Your server has been carefully inspected and calibrated before shipment to allow immediate 
operation upon installation.  Check all items for signs of visible damage which may have 
occurred during shipment.  If any item is damaged, contact the carrier to file a claim. 

Keep the packing materials in the event that a unit must be returned.  If the original packaging 
is not available, due to the product’s weight it should be professionally packed for shipment, 
with particular attention to protecting the corners. 

 

Package Contents 
Confirm that all items on the packing list have been received.  Contact 360 Systems if any item 
is missing. 
 

 MAXX-2420-EX server 
 Keyboard 

 2-Button Scroll Mouse. 
 USB flash drive containing backup copy of software and utilities. 

 CXP serial control and GPI module 
 CXP interface cable 

 Rack Mount Hardware Kit 
 Operations Manual and Warranty Card 

 Power cords (2) 
 
 

The server is not shipped with a video monitor.   Select a VESA-compliant CRT or LCD monitor 
with a minimum refresh rate of 75 Hz. 

If you own more than one server, it may be appropriate to use a single keyboard, monitor, and 
mouse with a KVM switch to select between servers. Not all KVM switching systems are 
compatible.  The KVM switch must supply an active signal to the server at all times, even when 
switched away from it.  When first powering up the server, use only the supplied keyboard and 
mouse directly connected.  Then thoroughly test the KVM switch system that will be used 
before installation is completed. NOTE: If the mouse and keyboard connections are 
interchanged, the server may not start up properly. Be especially cautious when using 
extender cables. 
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Important Installation Notes 

System Cooling 
When many pieces of equipment are mounted in an equipment rack, a considerable amount of 
heat may be produced, which must be removed efficiently.  Further, a lower operating 
temperature will make equipment operate more reliably, and it will last longer.  In the extreme 
case, excessive temperatures cause rapid equipment failure, and damage which can be difficult 
to repair.    

Heat in an equipment rack must be removed by forced air.  This is often accomplished by 
blowers installed in the top of the rack, venting into the room.  An alternative is to draw hot air 
from the top of the rack into an air-conditioning return duct, and not vent it into the equipment 
room. Cold air should be ducted into the bottom of the rack. 

The optimum air temperature for cooling electronic equipment is 25° C (72° F).  When many 
pieces of equipment are contributing to the heat load, a substantial air-flow will be needed, and 
the inlet temperature may need to be lower. 
 

Check These Points 

• Are the ventilation holes in the server free of obstruction? 

• Can blowers or HVAC system adequately remove heat from the equipment rack? 

• Have you measured the actual temperature inside the rack? Do this near the top. 

• Verify that the HVAC system is not on a timer that can shut off on weekends or holidays. 

• What procedures are in place to protect the equipment when the HVAC system fails? 

Power Conditioning 
It is good practice to operate an on-air video server from an Uninterruptible Power Source, or 
UPS.  All utility power systems experience occasional transient events, including brownouts 
and dropouts, which are capable of taking a server off the air.  It is the station operator’s job to 
plan for and overcome such contingencies. 

The minimum requirement for the MAXX-1200HD or MAXX-1200EX server is 3 amps. 

UPS units designed for handling short-term power line problems come in two varieties:  

Change-over UPS Design  

This design senses drop-outs and low line voltage, and switches its output to an internal 
inverter operating from a battery.  This UPS is low in cost, and is most often used in non-critical 
applications such as desk-top computers.  A disadvantage is that it may create its own power 
transients when switching between utility power and its inverter supply. For this reason, 360 
Systems does not recommend this type for use with a broadcast server. 
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Continuous Conversion UPS Design 

This improved design, sometimes called ‘double conversion’ continuously converts utility 
power to DC, stores it in a battery, then produces isolated AC power from an inverter.  It never 
switches back and forth to utility power, and has better immunity to input transients, 
brownouts, and blackouts.  Models are available with batteries of almost any size, making the 
continuous-conversion UPS suitable for transient suppression or long-term operating power in 
the absence of utility power. 

 

Server Operating Environment 
A video server is the most critical element in a broadcast operation. Its installation should 
safeguard it from every external event that can interfere with it doing the task expected of it. 
360 Systems’ engineers have experience with thousands of installations, and have become 
aware of a number of environmental factors that can adversely affect performance. Two of 
these have already been discussed: power conditioning and inadequate cooling.  Two others, 
less obvious, should also be considered: 

RF Interference by Cell Phones 

Many people are not aware that cell phones produce a very high instantaneous power output, 
even when no conversation is taking place. You may have experienced the effect of a cell 
phone interfering with a common desk phone placed nearby.  Carrying a cell phone into a 
machine room where it is in close proximity to broadcast equipment and its associated wiring 
is unwise.  Cell phones can interfere with serial control commands, video synchronization, and 
in some cases can crash the CPU in equipment. 

Some major broadcasters prohibit the presence of cell phones in certain equipment areas. 360 
Systems believes that the risk of undesired equipment behavior from their RF fields is very real. 

 
Static Discharge 

Static electricity discharge is accepted by most people as an inevitable consequence of living in 
a dry area.  It is also a result of floor coverings that may enhance appearances, but are 
inappropriate for use around critical broadcast equipment. Static discharge can do two adverse 
things:  

• Discharge into a connector can—and will—destroy internal circuitry of equipment.  The result 
will usually be difficult to diagnose.  

• Discharge to equipment frames or wiring can crash a CPU and take the station off the air. The 
event may seem random or unrelated to static, but it is clearly a catastrophic event—and one 
that can repeat indefinitely.  

Several steps can be taken to protect equipment from static discharge: 

• Do not install critical broadcast equipment (video servers) in a room with carpeting.  

• Connect equipment racks directly to the utility safety ground with a heavy copper conductor. 

• Do not operate equipment which has a lifted safety ground (green frame ground wire). 

• Consider installing a humidifier to reduce the likelihood of static discharge. 
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About Server Software 
The MAXX-2420-EX is shipped with its application programs and operating system installed. 
The first time that it is started, it must be connected to a keyboard, monitor and mouse.  The 
server will ask you to accept the Software Licensing Agreement before it will operate.  This 
screen will only appear during the initial startup. Refer to the Maintenance chapter of this 
manual if it becomes necessary to reinstall software. 

Rack Mounting 
In North America, the server will usually be mounted in a 19” rack enclosure having 10-32 
tapped holes.  In countries with metric standards, the user will need to supply appropriate 
fasteners. 

Remove the front panel to expose the rack screw slots.  Fasten the server into the rack using the 
#10 flat-head Phillips screws (provided for North America).  Replace the front panel and tighten 
its access screws until just snug.  

There may be four adhesive-backed rubber feet on the server.  These should be removed if rack 
mounting the unit. 

Cables attached to the rear of the server should be supported by the rack mounting rails.  Do 
not support substantial cable weight from the server. 

Mounting an Audio Module (AXP-3, AXP-4 or DXP-1)  
An optional multi-channel audio module may also be rack mounted above or below the  
MAXX-2420-EX, on the front or rear of the rack. Four elongated screw holes are provided to 
facilitate rack mounting of the AXP Module. Audio modules are connected to the server with 
the supplied 68 Pin cable. Connect one end to the mating connector on the rear of the audio 
module. Connect the other end to the rear panel of the server. 

Mounting the Control Module (CXP)  
The supplied CXP module may also be rack mounted above or below the MAXX-2420-EX, on 
the front or rear of the rack. Four elongated screw holes are provided to facilitate rack 
mounting of the CXP Module. The CXP module is connected to the server using the supplied 
68 Pin cable. Connect one end of the cable to the mating connector on the rear of the CXP 
Module. Connect the other end to the rear panel of the server. Refer to  Figure 4 on page 27 for 
information about connecting GPI and automation signals to the CXP Module. 

Connecting the Monitor, Mouse and Keyboard 
The MAXX-2420-EX is not shipped with a video monitor. Select a VESA-compliant CRT or LCD 
monitor with a minimum refresh rate of 75 Hz. Note that the MAXX-2420-EX may not start 
correctly if an unsuitable monitor is connected. Connect the monitor to the VGA port on the 
rear of the unit. Refer to Figure 1 on Page 24 

Connect the keyboard to the PS-2 keyboard port on the rear of the unit; connect the mouse to 
the mouse port. Refer to Figure 1 on page 24.  NOTE: If the mouse and keyboard connections 



 

MAXX-2420-EX Owner’s Manual Page 23 

are interchanged, the MAXX-2420-EX may not boot up properly. Be especially careful about 
this when using extender cables. 

See USB Ports on page 26 for information on using USB keyboard and mouse.  

If you own more than one MAXX-2420-EX, it may be appropriate to use a single keyboard, 
monitor, and mouse with a KVM switch to select between servers. Not all KVM switching 
systems are compatible.  The KVM switch must supply an active signal to the server at all times, 
even when switched away from it.  When first powering up the MAXX-2420-EX, use only the 
supplied keyboard and mouse directly connected.  Then test the KVM switch system that will 
be used thoroughly before installation is completed. 

Occasionally some KVMs will cause the mouse to stop responding or to behave erratically. 
Mouse operation can be reset by the keyboard sequence Control+Alt+F12 (the screen will go 
black) followed by Control+Alt+F7. 
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Rear Panel Connections 
Figure 1 indicates the Rear Panel connections on MAXX-2420-EX. Each connection is described 
briefly in the following text. Make all connections appropriate to other equipment before 
applying power to the MAXX-2420-EX. 

 
Figure 1 - Rear Panel Detail 

Rear Panel Connections to the MAXX-2420-EX Server 
 

Mouse  

Keyboard 
USB  

CXP Interface Connector  
RS-232 Serial Port (do not connect)  

VGA Monitor 
NET 1 - Gigabit Ethernet 

NET 2 - not used 
Channel 1 and 2 HD-SDI Inputs (bi-directional) 

Channel 1, 2, 3, 4 HD-SDI outputs  
Channel 1, 2, 3, 4 - CVBS monitoring outputs 

Channel 1 LTC Input 
Channel 2 LTC Input 

LTC Output 
Genlock Input  

Audio Module Connector (AXP or DXP) 
 
HD-SDI Video Inputs  

The MAXX-2420-EX records Digital video on channels 1 and 2.  It has separate BNC inputs for 
HD-SDI (serial digital per SMPTE 292M). HD-SDI inputs have a fixed 75-ohm termination.  

HD-SDI Video Outputs  
Channels 1, 2, 3 and 4 have HD-SDI video outputs per SMPTE 292M.   
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CVBS Monitor Outputs (Optional) 
Channels 1, 2, 3 and 4 have letterboxed composite video monitoring outputs.   

Genlock Sync Reference  
The MAXX-2420-EX is designed to be referenced to an external genlock source in the form of 
RS-170 black. The GENLOCK input provides a fixed 75-ohm termination. An internal crystal 
reference is also provided so that the server can be used as a stand-alone player. 

Gigabit Ethernet Port  

A Gigabit Ethernet port is provided on the MAXX-2420-EX.  The NET 1 port is intended for 
external transfer of program content between video servers. The NET 1 port is also used for 
remote control using the optional Remote Workstation software. The NET 2 port is reserved for 
future use and is not active.  Use only the NET 1 port. 

LTC Time Code Input  

An LTC time code input is provided for Channel 1 and Channel 2. The LTC input provides a 
>10k ohm termination. This input may be selected by means of the On-Screen user interface 
and recorded as a time code reference.  This input may be selected by means of the On-Screen 
user interface and used as a start time reference.  Note that time code is not actually recorded, 
the time code read at the start of recording is captured.  When the clip is played back, the time 
code (in display, VITC and LTC outputs) starts from the captured time and proceeds 
continuously.  

LTC Time Code Output  

An LTC time code output is provided on the LTC OUT BNC connector.  It may be selected by 
means of the On-Screen user interface to output time code from any of the four video channels 
during playback.  The LTC output has a source impedance of <5 ohms. 

Keyboard  

Attach the alphanumeric keyboard to the purple 5-pin KEYBD connector to control the server 
and manage clips with the On-Screen graphic user interface.  

Mouse  

A two-button scroll mouse is provided with the MAXX-2420-EX.  Plug the mouse into the green 
5-pin MOUSE port.  Mouse operation can be reset by the keyboard sequence Control+Alt+F12 
(the screen will go black) followed by Control+Alt+F7. 

Monitor  

A VESA-compliant computer monitor may be connected to the 15-pin VGA video port.  The 
MAXX-2420-EX resolution is fixed at 1024 x 768 pixels, with a refresh rate of 72 Hz.  This is 
best-viewed on 17-inch or larger monitors.  360 Systems does not provide monitors for the 
server.  Do not use older monitors that are not VESA compliant.  The server will not start 
properly if an unsuitable monitor is connected. 

Serial Port  

The rear panel serial port is not used. Make no connection. 
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USB Ports  

The rear panel USB ports are used for software updates. As of version 1.07.559 the USB ports 
can support keyboard and mouse operation, but it is still recommended to use PS-2 devices.  
Currently, a PS-2 keyboard is required for update operations using a USB drive as the limited 
operating system on the USB drive does not support USB keyboards. 

Power Switch (not shown in Figure 2) 

Shutdown the system only by momentarily pressing the front panel power button, or through 
the SHUTDOWN command on the On-Screen user interface.   

PRESSING THE FRONT PANEL POWER BUTTON FOR FOUR SECONDS WILL FORCE A 
SHUTDOWN. USE THIS METHOD ONLY IF THE UNIT IS NOT RESPONDING. 

Audio Module Connections 
 

The optional AXP-3, AXP-4 and DXP-1 multi-channel audio modules provide for connection of 
audio equipment. Each is a 2-rack space module. Connection is made to the rear panel of 
MAXX-2420-EX using a 68 pin cable. Figure 3 indicates the audio module’s connectors and 
their functions. 

 
 

CAUTION! 

Do not plug an audio module into the CXP connection. Damage to the system may occur. The 
audio connector on the MAXX-2420-EX is clearly marked.  Connect according to Figure 2. Be 
certain it is properly connected before applying power. 
 

 
 

   Connect Audio Module Here 

 
 

Figure 2 – Audio Module Connection to MAXX-2420-EX 
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Control Module (CXP) Connections 
The CXP Module provides connections to the server’s serial ports and its GPI interface using a 

68 pin cable. Connect it between the back of the CXP module and the CXP port on the back of the 
server.  
 

CAUTION!! 
Do not plug the CXP Module into the AXP audio module connection on the server. Damage to the 
system may occur. The CXP connector on the MAXX-2420-EX is clearly marked.  Connect the CXP 
module per Figure 3. Be certain it is properly connected before applying power. 

  
     Connect CXP Module Here 

 

Figure 3 - CXP Connection to MAXX-2420-EX.  

Serial Control Ports for Channels 1, 2, 3 & 4 
Each of the four 9-pin “D” connectors on the CXP module provides independent control of the 
four video channels.  They accept serial commands in VDCP, BVW or Odetics protocol.  The 
multiple serial ports allow simultaneous connection of an automation controller and a desktop 
controller.  See the chapter on Automation Control for further details. 

Most broadcast automation systems and some remote control panels employ VDCP protocol.  
Many controllers used for transport, instant replay, and edit control employ BVW or Odetics 
protocol. 
 

 
Figure 4 - CXP Module Connectors 

 

GPI Control  
The MAXX-2420-EX provides twelve GPI inputs for control of machine functions, which appear 
on two 25-pin GPI connectors.  This “General Purpose Interface” can be connected to switch 
contacts or to an open-collector transistor output.  GPI inputs are programmable, and can 
provide machine control such as PLAY, STOP, or RECORD through simple external switches. 
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The MAXX-2420-EX also provides twelve GPI outputs which may be used to confirm that a 
command has been received, or for other purposes.  The function of these open-collector 
outputs is programmable; they may be used to operate an LED, or they can drive a suitable 
logic input.  The pin-out for the GPI connectors will be found in APPENDIX A. 
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Basic Operations 
This section introduces the Graphic User Interface (GUI), its menus and operating controls.  If 
you want to skip ahead to learn how to record a clip, go to page 39.  Skip to page 46 to read 
about playing a clip. 

The graphic user interface is the primary way to manage server operations.  With it, you can 
control recording and playout, set up video and audio formats, map remote control ports to 
video channels, perform editing and make playlists.   

The GUI is operated with a keyboard, mouse, and monitor connected to the server rear panel.  
During the first power on the system must be connected to a keyboard, monitor and mouse.  
The server will ask you to accept the Software Licensing Agreement before it will operate.  This 
screen will only appear during the initial startup. 

The Server Desktop 
The server desktop is similar to many computer graphic interfaces. A task bar and start menu 
appear at the bottom of the screen.  Use the Start menu button to launch applications, manage 
the system or to shut down the server. 

Launching the Graphic User Interface 
The GUI launches automatically during start up. If it has been closed, click Start, then Image 
Server GUI to re-launch it. The GUI window can be moved or minimized as desired. 

Shutting Down the Server 
Click Start, then Shutdown, then select either Shutdown to begin an orderly shutdown, or  
Full Restart to do an orderly shutdown and restart (without a full power down). 

Alternatively, momentarily pressing the front panel power button will cause the system to begin 
an orderly shutdown.  The server will acknowledge the button press with an audible beep and 
the front panel lights will begin to flash together.  Any operation in progress will be halted, and 
any unsaved work will be lost. 

In most cases the power will shut off automatically.  However, if the front panel lights begin to 
blink, it means that the file system has been properly closed, and it is safe to force the power off 
by holding the front panel button in for 4 seconds. 

If the system has stopped responding to commands and will not reset by pressing the front panel 
button, press and hold the button for four seconds to force a power down.  Wait 5 seconds, and 
then the system may be restarted with another press of this button. 

DO NOT disconnect AC power to shutdown the server.  Doing so may cause loss of unsaved 
data, and may require the RAID drive array to re-synchronize – a process that could take several 
hours.  Shutdown the system only by momentarily pressing the front panel Reset button, or 
through the GUI. 

The Quick Restart option in the Start>Shutdown menu allows the GUI and video playback 
application to be restarted without restarting the entire operating system.  

The Restart FTP Only option will restart the FTP service without affecting video operation. 
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Graphic User Interface Overview 
Once the server has successfully powered up, the VGA monitor will display the GUI of Figure 5. 
This view provides: 

• A main System Menu bar for configuration operations  

• A Status Bar that displays various system messages 

• Four VTR-like transport controls, one for each video channel 
                     

 

Figure 5:  Graphic User Interface with Clip Transport Windows  
 

When using the mouse, all buttons of all channels will operate immediately, without first 
selecting a window to activate it. (Channel 3 is active in the illustration above, indicated by its blue 
title bar.)  

When using key commands, the active window is the only transport that will respond.  Use the 
CTRL+TAB key combination to change the active window in rotation, or use the mouse to activate 
the desired window by clicking anywhere in it. 

Windows can be moved, resized and overlapped by dragging the title bar, window edges, or the 
resize tab at the lower right corner of a window.  The CTRL+TAB key combination will also place 
the activated window in front of all other windows. 
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System Menu Bar 
The System Menu bar contains four menus: Show, Edit, Windows and Help. 

 

Show Menu 
Contains selections for the four Channels and the clip management windows. 

Channel 1 
Channel 2 
Channel 3 
Channel 4  

Opens the specified window if it is closed, brings it to the top and activates it. 

Key Commands – F1, F2, F3, F4 

Clip List 
Opens the Clip Navigator window if it is closed, brings it to the top and activates it. See page 57. 

Key Command – Ctrl+L. 

Find Clips 
Opens the Clip Locator dialog. See page 57. 

Key Command – Ctrl+F. 

Edit Menu 
Contains a single selection, Configuration.  This opens the main System Configuration dialog.  
See page 51. 

Windows Menu 
Choices in this menu change the way the windows are displayed.  Use the CTRL+TAB key 
combination to change the active window in rotation, or use the mouse to activate a specific 
window. 

Cascade 
Arranges all open windows so that they are overlapping, but offset.  It is useful as a starting 
point to rearrange the windows. This choice is especially useful with small monitors. 

Tile 
Arranges all open windows so that each is fully visible.  This choice is especially useful with 
larger monitors.  In case Windows do not tile as expected, select Cascade to restore their 
original size and order, then select Tile. 

In addition, there are selections for each open transport window.  Selecting one of these brings 
that transport to the top of the display and makes it the active window. 
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Help Menu 
Contains a single item, About, which displays the server software versions, serial number and 
Unit ID. 

The Status Bar 
A status bar appears at the bottom of the window that provides system information including 
GENLOCK, VIDEO INPUT DETECTED, and TIME REMAINING—PERCENT FULL.  Messages such as 
CONNECTED TO HOST or CONNECTION TO HOST REFUSED are also displayed as diagnostics.  Error 
and status messages from the RAID system can also be displayed here. 

 

Channel 1 and 2 can Record or Play video content. Channels 3 and 4 only play content. All channels 
may be used at the same time.  

 
 
Each channel can be controlled in two different views. 
 

• The Transport View 
• The Playlist View 
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The Transport Channel View 
The Transport Channel View is shown in Figure 6.  This is the default view of each channel. 
Basic transport operations such as play, stop, record, and head/tail trimming appear in the Clip 
Transport window for each channel.  These operate in familiar VTR fashion.  

 

 

Figure 6 - Transport Channel View 

Transport Menu Bar 
There are two menus, File and Options. 

File Menu 
New 

Channel 1 and 2 only.  Opens the Clip Navigator to allow naming of a new clip, then prepares 
channel 1 or 2 for recording. See page 37. 

Key Command – Ctrl+N. 

Open 
Opens the Clip Navigator to allow choosing a clip to load into the transport.  

Key Command – Ctrl+O. 

Save 
Saves an edited clip using its existing file name. 

Key Command – Ctrl+S. 
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Save As 
Opens the Clip Navigator to allow saving an edited version of the clip with a new name.  This 
allows making alternate versions of a clip or making multiple segments of a master clip. 

Key Command – Ctrl+A. 

Playlist 
Switches from Transport View to Playlist View. 

Close 
Closes the Transport window.  This has the same effect as the Close box in the upper right 
corner of the window.  Note that this will not stop playback or eject a loaded clip. 

Options Menu 
This menu contains two selections. 

Take Control 
Takes control of the video channel from another user (the Serial Control, a Remote 
Workstation, or if you are using a Remote Workstation possibly the local GUI.) This item is 
grayed out when the window has control. 

Key Command – Ctrl+T. 

Configure 
Opens the video channel’s Configuration dialog.  See pages 37. 

Key Command – Ctrl+C.  

Go To 
Opens the video channel’s Frame Locator.  See page 47. 

Key Command – Ctrl+G. 
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The Playlist Channel View 
The Playlist Channel View is shown in Figure 7. This view allows multiple clips to be loaded in a 
playlist for sequential playout. 

 

 
 

Figure 7 - Playlist Channel View 
 

Playlist Menu Bar 
There are two menus, File and Options. 

File Menu 
Open 

Opens the Clip Navigator to allow choosing a clip to load into the transport.  

Key Command – Ctrl+D. 

Append 

Opens the Playlist Selection dialog to allow choosing a Playlist to Append to the currently 
loaded list.  This can be done while playing to allow continuous playback of new Playlists.  
See page 66. 

Save 
Saves an edited Playlist using its existing file name. 

Key Command – Ctrl+S. 

Save As 
Opens the Clip Navigator to allow saving an edited version of the clip with a new name.  
This allows making alternate versions of a clip or making multiple segments of a master clip. 
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Key Command – Ctrl+A. 

Rename 
Opens the Playlist Selection dialog to allow renaming the currently loaded Playlist. 

Transport 
Switches from Playlist View to Transport View. 

Eject 
Ejects the currently loaded Playlist in preparation for creating a new one.  (It is not necessary 
to Eject a list to load another saved list.) 

Key Command – Ctrl+N. 

Close 
Closes the Playlist window.  This has the same effect as the Close box in the upper right 
corner of the window.  Note that this will not stop playback or eject a loaded list. 
 

Options Menu 
This menu contains two selections: 
 

Take Control 
Takes control of the video channel from another user (the Serial Control, a Remote 
Workstation, or if you are using a Remote Workstation possibly the local GUI.) This item is 
grayed out when the window has control. 

Key Command – Ctrl+T. 

Configure 
Opens the Playlist’s Configuration dialog.  See page 65.  Note that this is different than the 
dialog for the video channel setup, which must be accessed from the Transport View 
window. 

Key Command – Ctrl+C. 
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Initial System Configuration   

Selecting a Sync Reference 
In many applications, this server and downstream equipment connected to it must be referenced 
to a common genlock source (SMPTE 170M or ITU-R-BT.470). A BNC connector is provided on 
the rear panel to receive a genlock signal. It has a 75-ohm termination.  

An internal crystal reference is also provided so that the server can be used as a stand-alone 
player, and also for convenience for testing. Use particular care when operating the server with 
an internal reference, as synchronization with other equipment may not be possible.  Systems 
that incorporate retiming circuitry in the router or video switcher may not require referencing. 

Note that the input sync for recording is derived from the input itself.  The E-E output is 
synchronized to the input as well, so it is not possible to time the E-E output to gunlock. 

Setting the Video Sync Source 
To use with a genlocked system, select External Sync using the GUI as follows: 

• From the main menu bar select EDIT >CONFIGURE. Select the TIMING option. The screen 
of Figure 8 appears.  

• Select EXTERNAL as the sync source. 

• Check that the front panel GENLOCK LED is now illuminated and the word GENLOCKED 
now appears in the bottom right of the main GUI window. 

 

Genlock Signal Quality 

A genlock signal for the server must conform to one of the standards listed in the Technical 
Specifications. An unstable genlock source may result in unwanted artifacts in the video output . 

 
To use in a non-genlocked system, follow the instructions above but select INTERNAL Sync. 

The input to the server uses the input signal itself as a reference, this allows recording any signal 
that conforms to the currently selected video format and frame rate.   No configuration is 
required to use this feature. 
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Selecting a Video Format 
The MAXX-2420-EX can record and play video in four high definition video formats: 

 
1080i @ 59.94 Hz 1080i @ 50 Hz 
720p @ 59.94 Hz 720p @ 50 Hz 

 
To select a video format:  

• Go to Edit>Configure>Timing dialog on the GUI.  

• Select a check-box for the rate at which you will record or play.  

A reminder will appear, to stop video on all channels and prepare for automatic restart in the 
new format. This takes at least 12 seconds, so the change should not be performed on-air.  

 

 
 

Figure 8 – Selecting Video Format 
 

The MAXX-2420-EX must be set to operate in one format at a time; it does not play mixed video 
formats when the video format is changed, the only files visible on the GUI will be those 
recorded in the currently-selected video format. Files in another format will become visible when 
the server is placed in that operational mode. . For clarity, it is a good idea to store content in 
directories that are separated according to video format. 

Audio is recorded and played at the industry standard of 48K, regardless of the video format 
selected.  
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Making a Recording from the GUI 
Video recordings are made using the Transport View of Channel 1 or 2. These channels can 
record or play clips, but not both at the same time. Channels 3 and 4 are playback only. The 
following steps are used to make a recording. Most configuration settings can be skipped once a 
workflow is established. Channel 1 is used below as an example; all instructions apply equally to 
channel 2. 

Record Configuration Options 
If necessary, set Channel 1 and/or Channel 2 to the Transport View. Click FILE >TRANSPORT 
in the Playlist View to switch to the Transport View. 

Setting the Video Bit Rate 
Select OPTIONS >CONFIGURE from the Channel 1 Transport Window. The Dialog box in 
Figure 9 appears.  

• In the window, enter the desired Video Bit Rate (in Megabits/sec), not to exceed 125. 
Alternatively, use the up/down arrows to set a number. 

• Click APPLY or OK. 

 

 

Figure 9 - Channel Configuration Dialog 
 

The recommended bit rate is 70 to 80 Mb/s, especially for applications requiring file transfer 
while three or four channels may be in use. Rates over 80 should be used only for applications 
requiring reproduction of very high detail material. 
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Setting the Audio Input Source 
Select OPTIONS >CONFIGURE from the Channel 1 Transport Window.  The Dialog box in 
Figure 9 appears.  

• Select an Audio Input by clicking the desired button.  

• Click APPLY or OK. 
 

Embedded audio is eight tracks contained in the HD-SDI video stream. 

AES/EBU Digital Audio refers to audio input from the optional DXP-1 multi-channel module. 

Analog Audio refers to audio input from the optional AXP-3 and AXP-4 multi-channel module. 

Arming Audio Tracks 
• Select OPTIONS >CONFIGURE from the Channel 1 Transport Window. Refer again to 

Figure 9 - Channel Configuration Dialog. 

• Under TRACK ARM, check the AUDIO box if recording audio is desired. All eight tracks are 
recorded.  

• Click APPLY or OK 

Setting an Audio Delay Time  
Audio tracks can be offset from video in 1 millisecond increments up to +/- one second. The 
setting is per channel and non-volatile. It applies to playback only, not recording.   

You must stop and start the playback to hear the result of a change.  This adjustment is made in 
Transport mode; once set it also applies to Playlist mode on that channel. 

• Select OPTIONS >CONFIGURE from the Channel Transport Window. The Dialog box in 10 
appears.  

• Click the OUTPUT tab. 

• Enter a time offset value in the window.  

• Click APPLY or OK. 
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Figure 10 - Audio Delay Time Offset 
 

Audio Rate Conversion 
• Converting the sample rate for audio applies only to AES/EBU digital audio. It is not relevant to 

analog audio, or Embedded audio. Select OPTIONS > CONFIGURE from the Channel 1 
Transport Window. The dialog box in Figure 5 appears.  

• Check a box under Audio Rate Conversion only if the corresponding AES/EBU audio source is 
not a video-referenced 48K sample rate (as with wild audio or 44.1K audio).  

• Click APPLY or OK. 

 

Bit-for-Bit® Recording & Playback 
Dolby®-E, Dolby Digital (AC-3) or other forms of compressed audio require that on playout, the data 
stream be identical to the original.  Do not use the audio sample rate converters when working with 
these encoded audio formats. Further, the Dolby® encoder must be supplied with the same video 
reference as the HDSDI input to the server. 

Audio Output Sync Reference 
The audio sample rate is derived from the selected video sync reference.  Audio is recorded at a 48K 
sample rate, so the 0.1% pull-down for 59.94 Hz video is taken into account when generating the 
sample rate.   
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Setting VANC Line Selections 
• Select OPTIONS >CONFIGURE from the Channel 1 Transport Window. The Dialog box in 

Figure 9 appears.  

• Check the VANC box if Vertical interval ANCillary data (VANC) is to be recorded along with 
video.  

• The VANC line selection data entry box will become active. Enter desired line numbers, 
separated by a comma. Ranges can be specified with a dash, such as “9-12”. Lines 9,10 11 
and 12 will be included. 

• In 720p, enter up to 12 lines. In 1080i, enter up to 6 lines.  The six lines will be recorded in 
both field 1 and the corresponding lines in field 2. 

• Click APPLY or OK. 

Selecting a Time Code Source 
This high-definition server utilizes the time code standard specified in SMPTE 12M-1, and applies 
it as described in SMPTE 12M-2. It is suggested that the user refer to these documents, as HD 
time code differs significantly from standard definition methods.  

• This function selects the source for time code for new recordings.  The time code value 
obtained from the selected source will be applied from the beginning of a recording.   

• Select OPTIONS >CONFIGURE from the Channel 1 Transport Window. The Dialog box in 
Figure 9 appears.  

• The default Time Code Source is MANUAL. Alternatively, ATC (Ancillary Time Code ) may 
be selected. 

• For MANUAL, enter a time value in the window for the first frame of the recording. Use the 
HH:MM:SS:FF format.  It is not necessary to enter the colon ( : ) between digit pairs. 

• Click APPLY or OK. 

 

Beginning Recording 
When the setup steps outlined above are complete, you are ready to record.  Place Channel 1 in 
the Record Ready mode as follows.  

There are two approaches to starting a recording: “named recording” and “crash recording”. You 
can name the clip first, then press Record; or just start recording, and let the system generate a 
clip name automatically. The clip may be renamed as desired when the recording is complete. 
The advantage of the first approach is that when the recording is complete, it is fully identified 
and ready for use; the second approach is valuable for live action such as sports, where there is 
no time to lose and action must be captured at once. 

Clip names for crash recordings are of the form “new MMDD_N”, where MMDD represents the 
month and day of the recording, and N is the lowest non-zero number that does not cause the 
name to conflict with any previously made recording. 
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Making a Crash Recording 
Press Record whenever Channel 1 reports that it is IDLE. 

Making a Named Recording 
• From the Channel 1 Transport Window, Select FILE>NEW. The dialog of Figure 11 appears. 

 

 

Figure 11 - Channel 1 Clip Navigator "New" mode 

 
• Enter a clip name using the keyboard. Up to 31 characters may be used.  Spaces are allowed; 

however, some characters other than upper or lower case letters and numbers may not be 
used.  These characters will not enter into the name field when typed. They include * ( ) + = 
; : ‘ “ < > , . / and ?  A list of existing clips will appear in the large window, and can be used 
as a name reference when creating new clip names.  

• The Channel 1 transport Window will display the words IDLE CUEING for two seconds or 
less. When ready to record, the Channel 1 Transport Window will display IDLE READY. 
 

Note: File naming is case sensitive.  Upper case letters sort before lower case.  The name FILE sorts 
in the order shown, based on differing capitalization:  FILE, File, fiLe, and file.  When using the 
server with automation systems or other remote controls, it is not a good practice to distinguish files 
only by differences in case. 
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Figure 12 - Channel 1 Ready to Record 

 
• Click the RECORD button at any time to begin recording. The yellow time display counters 

will update the clip duration continually. 

• To stop recording, click STOP. 

 

Note: An in-progress recording must be 2 seconds long before it will appear in the clip list. Hitting 
the STOP button to end the recording after less than 2 seconds will also cause the clip to appear in 
the clip list. 

 

Monitoring a Recording Source with E-E Mode  
The E-E button appears in the Channel 1 and Channel 2 Record/Play window. It allows the input 
signal to be monitored from the server output.  E-E Mode toggles automatically as described 
below, but can also be switched manually at any time. 

When a new clip is created for recording, the input source is automatically switched ON to the 
output—an E-E connection.  When a clip is opened for play on Channel 1 or 2, E-E monitoring is 
switched OFF.   

When Channel 1 or 2 is switched to playlist mode, the E-E monitor is switched OFF.  E-E mode 
cannot be toggled while the channel is in playlist mode. 

When E-E is ON, the input video signal is routed to the outputs.  Manually toggle the E-E mode 
button OFF to switch the output to the servers output, for conventional playback operation. 
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Under automation control, Auto E-E behavior is slightly different than under GUI control.  The 
server will remain in E-E ON mode until a transport control command (Play, Stop, Jog, etc) is 
received.  After receiving such a command, the server will remain in E-E OFF mode until record 
mode is entered.  In record mode, E-E mode is ON.  As with GUI operation, automation 
controllers may send E-E ON and E-E OFF commands to override the automatic operation. 

Note that when in E-E mode the video outputs are not timed to the genlock signal. This will not 
be noticeable when connected directly to a monitor. However, there may be timing offsets when 
feeding timed routers or switchers.  The symptoms of this will vary depending on the particular 
equipment, including horizontal picture shift or timing error indications.   If the input is not 
synchronous with genlock, it may roll vertically.  E-E mode is not intended to be used on-air, 
only as a production tool. 

All VANC lines are passed through E-E regardless of which lines are selected for recording.  
Similarly, all embedded audio is passed through even though only the first 8 channels are 
recorded. 
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Playing a Clip from the GUI 
Video Playback can be done on all four channels, individually or simultaneously. The record-
capable channels (1 and 2) can record or play, but not both at once. Follow these steps to play a 
clip: 

Beginning Playback 
 

1. Select FILE >OPEN from the Transport Window of Channel 1, 2, 3 or 4. The Clip Navigator 
shown in Figure 13 appears. 

2. Navigate the folder structure if necessary by clicking on the folders. 

3. Select the clip to be play by double-clicking it. 

4. When the Transport Window indicates Idle Ready, the clip can be played by clicking PLAY. 
 

 
 

Figure 13 – Channel-1 Clip Navigator in “Open” Mode 

Looping a Clip 
Clicking on the LOOP checkbox in the Transport View will cause a clip to loop until LOOP is 
unchecked, or until STOP is clicked. LOOP may be checked or unchecked before or during 
playback, but must be changed at least 2 seconds before the end of clip to take immediate effect. 

Pausing a Clip 
Click PAUSE at any time to pause a clip. Click again to resume. The PAUSE button is the same 
key as the PLAY button. 



 

MAXX-2420-EX Owner’s Manual Page 47 

Ejecting a Clip 
Ejecting a clip effectively removes it from the transport. The channel will output Black. Press 
EJECT to eject a clip.  

Using Jog 
The JOG + command will move to the next frame and go to Still.  The JOG – command will 
move to the previous frame and go to Still. 

Using Go To Frame and the Frame Locator 
Click the arrows |< or >| to go to the next trim point (Mark In or Mark Out) in the selected 
direction.  When in Edit mode, an additional click in the selected direction will go to the actual 
beginning or end of the entire clip. 

To use the Frame Locator slider, either select Go To from the 
Options Menu of the Transport you are using, or type Ctrl+G 
with the desired Transport selected (click anywhere in the 
Transport window to select it - its title bar will turn blue.) 

Using the mouse, drag the slider to move rapidly through the 
video file. Or, type a specific frame location into the Destination 
field.  You can type just as much of the location as necessary, by typing frames, seconds and 
frames, minutes and seconds and frames, or hours and minutes and seconds and frames.  (You 
can type the colons but they are not required.)  Press Enter when done. The video will jump 
to the specified frame (if it exists) and the Destination Field will become selected again to allow 
another location to be entered. 

 

 

Using Fast Forward / Rewind  
F-F (Fast Forward) and REW (Rewind) buttons transport program material at high speed in the 
chosen direction.  Four speed choices are available in each direction. Click the button repeatedly 
for: 4x, 16x, 64x, and 128x.  Audio does not play at any speed beyond +2X/-1X. 

Slow Motion Playback 
The MAXX-2420-EX will play smooth slow-motion video in forward or reverse, at any speed from 
zero to 2X forward or 1x reverse. Direction can be instantly changed, using either the GUI or a 
desk-top controller. Audio is also played at these lower speeds. At speeds beyond +2X/-1X, 
video frames will selected as needed, yielding a chunky result; audio is muted at high speeds. 
Most slo-mo playback for sports and other uses lies well within the +2x/-1x zone.  

To play in slow motion from the GUI, press PLAY and then move the shuttle slider to the desired 
speed—within a range of 2X range forward or 1X reverse. See the following section for details on 
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the Shuttle control. For faster playback from the GUI, use the FAST FORWARD or REWIND 
buttons as described in the preceding section. 

In sports, slow-motion control is usually accomplished with a desk-top slow-mo controller, such 
as those made by DNF Controls and others. These provide a hands-on experience far preferable 
to using the GUI. 

Using Shuttle to Control Playback Speed 
The Shuttle Control is a slider bar that controls playback speed. Playback speed control employs 
varispeed algorithms that may skip frames. It is not a perfect fast motion mechanism. 

The center position represents zero speed, or Still. 

The right and left extents of the slider represent +2X/-1X maximums. 

The Shuttle control slider works in three basic ways: Snap-Back to still, Hold Speed, and Mouse 
Wheel. 

• In Snap-Back operation, click and drag the slide control to change speed.  Releasing the slider bar 
will let it snap back to zero speed, or still. 

• For Hold Speed operation, position the cursor over the slider control scale (not the slider arrow) 
and click the left mouse button to increment the speed control.  The transport will run in the 
selected direction at the selected speed without holding the mouse button down.  The cursor 
may now be moved over the Stop button to wait for the desired point. 

• When using a wheel mouse, position the cursor over the slider scale and rotate the wheel to 
increment speed.  Rolling the wheel in opposite directions changes the direction the arrow slider 
moves.  To stop video, click the Stop button or the arrow slider. 
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Editing a Clip 
Edit controls are activated with the Edit check box.  Several buttons are available to define the 
beginning and end of a region within a clip; associated time code displays are also present. 

These non-destructive Mark In and Mark Out trim points can be set to define a portion of a clip 
to be played.  These “edit pointers” do not create a new clip from the original material; they act 
like virtual trims, and material outside of the trim points is excluded, but can be retrieved by 
resetting the Mark pointers.  After setting the Mark In and Mark Out points, clips will play 
between these points.  These edit values are saved with the clip. 

Edits may be saved to the current clip by de-selecting the Edit check box, or choosing Save from 
the clip window File menu.  Save As works to save the edit points to a new clip name, even if 
the edits have not been saved in the current clip.  This is a great help while conducting an Edit-
while-Recording. 

Using Edit While Recording 
Clips are most often edited after recording is complete, but it is sometimes desirable to create 
sub-clips while the recording is still in progress.  This is the preferred way to extract sports 
highlights, for example. 

Clips become available for editing about two seconds after the recording begins. Open the 
recording on either Channel 2 or 3 by selecting the clip name from the FILE>OPEN menu. (A 
recording must be 3 seconds long before it will appear in the clip list.) 

Use the transport controls to select and mark the In- and Out-Points, as desired. 

Without un-checking Edit, select FILE>SAVE AS, enter a new clip name, and click Enter.  A 
new clip is created that will play only between the In-Point and Out-Point.  This clip can now be 
played on the third or fourth channel, or assembled into a playlist. 

Next, use the transport controls to locate another set of In- and Out-Points for a second segment, 
and repeat the Save As command. 

As noted above, it is usually easier to leave the edit channel in Edit mode when you plan to 
make multiple “Saved As” clips.  If you de-select Edit with unsaved changes, you will be given a 
choice to save or discard the edit points.  Remember that you will be saving the edits to the file 
that is currently being recorded. Re-editing is required to see parts of it outside the region 
defined by  
Mark In and Mark Out, even if the recording continues after the editing session. 

Marking the IN point  
Sets the current time code value into the Mark In point time display.  The Mark In button can 
capture a time code value from the clip when it is still, or on-the-fly.  

Mark In Display 
Displays the time code of the Mark In point.  When no Mark In point has been set manually, this 
displays the Start of Message (SOM) time code (usually 00:00:00:00). 
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The values in this display window may be set by two methods: 

• Enter Mark In point from the keyboard:  Use the mouse or Tab key to move between In and 
Out fields.  When a field is highlighted, enter a numeric value from the keyboard. 

• Whether a clip is still or playing, press Mark In to capture a time code value from the clip’s 
current position. 

Marking the Out Point 
Sets the current time code value into the Mark Out point time display.  The Mark Out button can 
capture a time code value from the clip when it is still, or on-the-fly. 

Mark Out Display 
Displays the Mark Out point time code.  When no Mark Out point has been set manually, this 
displays the EOM time code (originally the end time of the recording). 

The values in this display window may be set by two methods: 

• Enter Mark Out point from the keyboard:  Use the mouse or Tab key to move between In and 
Out fields.  When a field is highlighted, enter a numeric value from the keyboard. 

• Whether a clip is still or playing, press Mark Out to capture a time code value from the clip’s 
current position. 

Duration Display 
Displays the total running time (TRT) of the current clip.  TRT is defined as the difference in the 
time codes between the first and last frames, plus one. For example, if the first frame of the clip is 
00:00:00:00 and last frame displayed at the end is 00:00:01:15, the reported duration will be 
00:00:01:16. 

With 59.94 Hz drop-frame time code, the true play duration may not be the exact numerical 
value of ((Mark Out – Mark In) + 1) due to the discontinuities in the drop-frame time line. The 
true run time is shown in the Clip Navigator. 

Auditioning the Mark In Point (Review Clip Button)  
The Review Clip button   |<–>|   cues the clip to the Mark In point (or SOM, if no Mark In 
point exists) and begins playback.  Review Clip will stop at the Mark Out point.  The Mark Out 
point will be displayed in Still mode. 

The Review Clip button may be used to check the Mark In point without playing all the way 
through the clip.  After Review Clip is pressed and play begins, all of the standard transport 
buttons are available for use. 

Auditioning the Mark Out Point (Review Out Button) 
The Review Out button     –>|      may be used to audition the Mark Out point without playing 
all the way through the clip.  It will cue the clip to three seconds before the Mark Out point (or 
EOM, if no Mark Out Point exists) and then begin playback.  Review Out will stop at the Mark 
Out Point. 

Single-Frame Clips 
It is possible to Click Mark In and Mark Out on the same frame to create a still frame for use in a 
playlist.  These can function as either a hold point in the list that will display the frame until 
another action is taken, or they can be assigned a duration. See page 67 for information on 
setting the duration of a still frame in a playlist. 
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System Configuration 
The following configuration options apply to the server as a whole, except where it applies 
specifically to an individual channel. 

Assigning Names to the Server and Transport Channels 
The server can be assigned a name that will be displayed along the top of the Main GUI 
Window. Each individual server channel can also be given a name.  

To assign a name to the server or transport channels, click EDIT>CONFIGURE>NAMES from 
the main menu pulldown.  

The screen of Figure 14 is displayed. Use the keyboard to type in a name for any of the 
selections. Names can be up to 31 characters in length. Spaces, digits and other non-
alphanumeric characters may be used. Click APPLY to accept the name. The names will appear 
in their appropriate windows immediately. 

 

 
 

Figure 14 - Configure Names Screen 
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Programming GPIO Outputs 

The MAXX-2420-EX has twelve General Purpose Outputs, referred to as GPO 1 through 12.  Each 
can be programmed to go active on the selected channel when one of the following events occurs: 
 

IDLE  Transport returns to idle 
PAUSED  Transport is paused 
STOPPED Transport is stopped 
PLAYING Transport is playing 
RECORDING Transport is recording 
RAID System Fault  RAID or System Fault  
NO GENLOCK No genlock 
NO VIDEO INPUT No video at the selected input 
PLAYLIST  Control GPO via playlist  

 

To program a GPO output, select EDIT >CONFIGURE >GPO.  The screen of Figure 15 is displayed. 
GPO 1 through 12 are triggerable outputs. The checkboxes to the right of each selection represent 
channel 1, 2, 3 and 4. GPO 9 is shown with the trigger option pulldown expanded. 

• To activate one of the GPO, pulldown the event menu and select which event will activate 
the GPO.  

• Select an associated channel where applicable by checking the channel checkbox.  

• Click APPLY to activate. 

 

 

 

Figure 15 - GPO Configuration Screen 
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Programming GPI Inputs 

The MAXX-2420-EX has 12 General Purpose Inputs, referred to as GPI 1 through GPI 12.  Each can 
be programmed to trigger one of the following events on a channel: 
 

CUE Cue a clip 

JUMP Cue selected clip for immediate playback   (Playlist Mode only) 

NEXT Immediately plays next cued clip in a playlist for playback (Playlist 
Mode only) 

PAUSE Pause a clip 

PLAY Play a clip 

RECORD Start a recording 

SELPREV In Playlist Mode – Navigate to clip above currently selected clip 

SELNEXT In Playlist Mode – Navigate to clip below currently selected clip 

STOP Stop a clip 

    

To program a GPI Input, select EDIT >CONFIGURE >GPI. The screen of Figure 16 will be 
displayed. GPI 1 through 12 are programmable inputs. The checkboxes to the right of each selection 
represent video channels 1, 2, 3 and 4. GPI 9 is shown with an expanded pulldown for trigger 
option. 

1. To activate a GPI input, select the event from the pulldown the event menu  

2. Mark a checkbox for the channel of interest. The event will be triggered when that GPI goes 
active.  

3. Click APPLY to activate. 

 

Figure 16 - GPI Configuration Screen 
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Configuring the Ethernet Network 
MAXX-2420-EX provides a number of user settings that configure it for use in a practical network.  
These will be found on the Configure Network tab shown below. 

The NET-1 Ethernet port on the server has a unique IP Address.  In this way, each server can be 
identified on the network.   

Network Settings Tab 
Use the Main Menu selection bar at the top of the server GUI to configure network 
communication settings. 

Click EDIT >CONFIGURE >NETWORK 
The screen of Figure 17 is displayed. 

 
Figure 17 - Network Configuration Screen 

 
The server is shipped with a default network Host Name and IP Address.  Qualified network 

engineers may change these configurations to suit your specific network environment.  Factory 
defaults for networking are: 

• Network Disabled 

• Use DHCP 

Disable Network [X] 
This selection turns the network OFF or ON.  The default is Disabled (the box is checked). To 
Enable the network connection, click the box to un-check it.  Disabling the network can be used 
to deny access to the server from the network for security purposes. 
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Enabling/Disabling DHCP [X] 

Enabling DHCP will configure the network interface automatically. 

If the DHCP box is not selected, the user may then manually enter assignments in the following 
windows: 

• IP Address   ( Example: 192.168.1.20 ) 
• Net Mask  ( Example: 255.255.255.0 ) 

• Default Router ( Example: 192.168.1.1 ) 
The Host Name and NTP domain name may be a fully qualified domain name, such as 
edit1.mydomain.com.  All other manually configured addresses must be properly formatted IP 
addresses. 

Saving Network Configuration 

Click on OK, APPLY, or CANCEL to accept or abandon new entries.  

The IP address of the system is displayed in the upper-left corner of the GUI at the end of the 
main window title. 

 

 

IMPORTANT 
 

The server is designed to be used in a private dedicated video network.  An external  
firewall (preferably with Virtual Private Network (VPN) support) must be used in systems 
that require internal security or connection to public networks. 
 
Consult with a network security specialist for guidance on the best hardware, programming 
and practices for your facility’s requirements. 
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Setting the Date and Time  
 

Click EDIT >CONFIGURE >DATE/TIME. The dialog below appears. 

 

 
 

Figure 18 - Time/Date Configuration Screen 
 

Select the REGION and ZONE according to your geographic location or time zone. Use the 
scroll-bar as necessary, and then click on the desired value. 

 
Set the TIME and DATE by clicking on the Time/Date field and navigating the clock and 
calendar. 

 
Check Automatic Updates to enable automatic updates using the Network Time Protocol 
(NTP). Refer to Network Time Protocol on page 88. 

 

 
           Note: A System Restart is required for a Time Zone change to take effect 
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 Clip Navigator 
The MAXX-2420-EX’s Clip Navigator is used to find, select, delete, name, and rename clips. 

Clips can be dragged and dropped anywhere on a Transport for immediate playback. 

Single or multiple clips can be dragged into a Playlist.  See page 62. 

• Click SHOW >CLIPLIST from the main pulldown menu to display the Clip Navigator. 

 

Figure 19 – Clip Navigator 

Renaming and Deleting Clips 
Clips can be renamed by right clicking on them with the mouse, then selecting Rename from the 
pop-up menu.   

Clips can be deleted by right clicking on them with the mouse, then selecting Delete from the 
pop-up menu. 

Sorting Clips 
Clips can be sorted in forward or reverse order by any of the columns by clicking once or twice 
on the column heading. The previous sort is maintained, so if the sort is by Name, then by 
Profile, the clips of each Profile will be sorted by Name.   

Filtering the Clip Display 
You can limit the number of clips displayed by typing a string in the FILTER window. For 
example, typing “AT” in the filter window would limit the display to all clips that contain “AT” 
somewhere in the clip name. Pressing the Clear button restores the complete display. 

Finding Clips 
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Clips can be easily found using the Clip Locator. To locate a clip: 

1. Click SHOW>FIND CLIPS. The Clip Locator screen of Figure 20 appears. 
2. Check Case Sensitive to make the search case-sensitive. 

3. Check Stop After First Match to find only the first match. 

4. Check Use Regular Expressions to search for the string of interest ANYWHERE in the clip 
name. With Regular Expressions unchecked, the search will match only clips that BEGIN 
with the string entered at FIND. See the next page for more on Regular Expressions. 

5. Optionally, Enter a string in the FILTER field to limit the number of clips displayed. For 
example, entering “AT” in the FILTER field will limit the display to only clips containing “AT” 
in their clip name. Pressing the Clear button restores the complete display. 

6. Enter a name or part of a name in the FIND field. Press Enter to initiate the search. The 
clip(s) will be displayed according to the rules set by the checkbox settings. 

 

 
 

Figure 20 - Clip Locator 
 

Finding Clips Using Wildcards 
The following wildcard conventions may be used in a search when Use Regular Expressions is 
unchecked. 

* Match anything.  For example, to find all clips starting with “xyz”, use the pattern “xyz*”.  
To find all clips containing “2008” use “*2008*”. 

? Match any single character. 
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Finding Clips Using Regular Expressions 
A regular expression (“RE”) specifies a pattern to be matched in a clip name. Regular expressions can 
contain both special and ordinary characters.  Ordinary characters just match themselves.  Thus, the 
RE “night” would match the “night” in the clip name “Tonight Show”, so this and any other clip 
name with “night” in it would be placed in the list of found clips. 

 
The following special characters are supported:  
.  (dot)  This matches any single character.  “a.c” matches “abc”, “aac”, “a2c” and “a c” but 

not “acd”. 

^ (caret) This matches the start of a clip name.  To find all clips starting with “xyz”, for 
example, use the Regular Expression “^xyz”. 

$ Match the end of the clip name.  To find all clips ending in “xyz” use the RE “xyz$”. 

< Match the beginning of a word.  For example “<Show” will match all clip names 
containing a word that starts with “Show”, such as “Now Showing”, but not “LateShow”. 

> Match the end of a word. 

* Match zero or more repetitions of the preceding character.   “.*” will match anything – 
“G.*N.*” will match “Georgia Evening News” or “Good Night”. 

+  Match 1 or more repetitions of the preceding RE term. “0+” matches 00 or 0000, not 0. 

? The preceding Regular Expression term is optional. “ab?c” will match “ac” or “abc” but 
not “adc”. 

[ ]  Used to indicate a set of characters. Characters can be listed individually, or a range of 
characters can be indicated by giving two characters and separating them by a "-". Special 
characters are not active inside sets. For example, [a+$] will match any of the characters 
"a", "+", or "$". [a-z] will match any lowercase letter. [a-zA-Z0-9] matches any 
letter or digit.  If you want to include a "-" inside a set, precede it with a backslash (“\-“), 
or place it as the first character. You can match all characters that are not within the set by 
making "^" as the first character of the set; "^" elsewhere will simply match the "^" 
character. For example, [^7] will match any character except "7".  

SPACE A space is treated as an ordinary character.  “ Show “ (<space>Show) will match 
“Tonight Show” or “Now Showing” but not "NewShow”. “ “ will match any clip with a 
space in the name. 

The subject of Regular Expressions is much larger than can be completely covered here.  They are 
used in several different operating systems and programming languages.  Further information can be 
found on the internet and in books on Regular Expressions and Linux. 
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Using Playlists 
MAXX-2420-EX’s Advanced Playlisting software provides extensive tools for building, editing and 
playing complex sequences of program content.  Advanced Playlisting appears as on-screen 
windows, with an intuitive Graphic User Interface that makes it easy to operate without extra 
equipment.  It’s invaluable for building commercial breaks, news rundowns, still-store and clip 
lists.  The server will create and store as many playlists as needed, each with its own unique 
name.  For many users, Advanced Playlisting may be all that’s needed to go to air.  
 

The following features are included: 

• Drag-and-drop playlist building and editing on a graphic interface 

• Edit lists while they’re running 

• Start at any point in a list 

• Displays run time for clips, plus segment length and total remaining time 

• On-the-Fly commands for Pause, Skip, Hold, Next and Jump functions 

• Append a playing list with a saved playlist 

• Up to 12 programmable GPI Output events embedded in playlist clips 

• Programmable time-of-day start for a playlist 

• Generates an As-Run Log 

• Setting rules for deleting old material on the playlist 

• Simple text format allows playlists to be created, viewed and edited offline 

• FTP access allows playlists to be transferred between servers, or to/from a PC 
 

For information about the playlist and asrun file formats, external list editing and use with traffic 
systems, see Appendix D on page 139. and Appendix E on page 142. 
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The Playlist View 
The playlist view for channel 1 is shown in Figure 21. Its functions are briefly described here. 
Table 1 provides an overview of Playlist control functions and their associated hot-keys. 

 

 
Figure 21 - Channel 1 Playlist View 

 
 

FUNCTION DESCRIPTION / REFERENCE INVOKE HOT-KEY 
PLAY/ PAUSE Play / Pause a clip ( Page 46, 64 ) PLAY Button P or SPACE 
STOP/ SHOW Stop / Show First Frame  ( Page 64 ) STOP Button S 

CUE Cue a clip ( Page 64 ) CUE Button C 
NEXT Prepare next clip for playback ( Page 64 ) NEXT Button N 
JUMP Jump to the selected clip ( Page 64 ) JUMP Button J 
LOOP Check to loop a Playlist ( Page 64 ) LOOP 

Checkbox 
L 

EDIT Check to enable editing ( Page 66 ) EDIT 
Checkbox 

E 
 

ARM START 
TIME 

Enable Scheduled Start Time  ( Page 63 ) ARM  
START TIME 

Checkbox 

T 

HOME Scroll to currently playing Clip ( Page 65 ) HOME Button H 

 
Table 1 - Playlist Control Functions 
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Creating and Running a Playlist 
To Create a Playlist (Using Channel 1 in the example): 

1. Change the transport for Channel 1 to the Playlist View. Click FILE >PLAYLIST in 
the Channel 1 transport pulldown menu. The window of Figure 22 appears.  

2. Click the EDIT check box to put the channel into edit mode. 

3. Click SHOW >CLIP LIST from the main menu to open the Clip Navigator. Both 
windows are now visible.  

4. Double click on a clip in the Clip Navigator to add it to the Playlist. The clip will 
appear in the playlist. The first clip will indicate a status of CUED.  Alternately, click 
on any clip and hold the mouse button as you move the cursor to the playlist.  Let go 
of the button when the cursor is over the position that you want the clip to appear in 
the playlist (drag and drop). 

5. Repeat the procedure to add more clips. 

 

Figure 22 - Channel 1 Playlist with Clip Navigator 
 

6. Click PLAY to run the playlist. The clips will be played in the order they were entered 
in the playlist. The currently playing clip will indicate a status of PLAYING. The next 
clip on the list will indicate a status of CUED. 
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Figure 23 – Active Playlist 

7. To SAVE the Playlist select FILE >SAVE-AS. Enter a file name. Click SAVE. 

8. To SAVE an existing playlist without changing the name, use FILE >SAVE. 
 

Loading a Playlist (FILE>OPEN) 
Click FILE >OPEN from the Playlist View to bring up the list of available Playlists. Double-click 
on a playlist to load it. 

Saving a New Playlist (FILE>SAVE AS) 
Once a Playlist has been created, it can be saved by selecting FILE >SAVE AS from the Playlist 
View pulldown menu. Type in an appropriate name and click SAVE. 

Saving an Existing Playlist (FILE>SAVE) 
An existing Playlist can be saved by selecting FILE >SAVE from the Playlist View pulldown 
menu. Type in an appropriate name and click SAVE. 

Setting Playlist Start Time 
Set a start time for a Playlist by entering a twenty four hour time of day in Hours, Minutes and 
Seconds in the START TIME field (see Figure 21 ). Click on any field to edit the field. Check the 
ARM START TIME checkbox to arm the start time. The ARM START TIME checkbox will 
automatically uncheck itself once the playlist has started. 

Triggering the Start Time is essentially the same as pressing the Play button, so it is possible to 
arm the start time while a list is playing, have the playback stop from a Hold or GPI Stop, and 
then restart when the Start Time triggers playback. 
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Stopping a Playlist (STOP) 
Click STOP to halt a Playlist. 

Pausing Playlist (PLAY/PAUSE) 
When a Playlist is running, the PLAY key will change to indicate PAUSE. Pressing PAUSE stops 
the Playlist immediately, on the current frame of a clip. Pressing it again will resume playback. 

Cueing a Clip (CUE)  
When the Playlist is running, click CUE to immediately prepare a selected clip for playback. 
When the current clip is finished playing, the Playlist will play the Cued clip, followed by all 
subsequent clips.  This allows the user to skip over clips that appear in the list between the 
currently playing clip and the selected clip.   

The user may also re-cue a clip that has already been played.  In this case, the Playlist will restart 
from the selected clip, and all subsequent events will be played (or re-played) in sequence.  
When the Playlist is stopped, CUE will prepare the selected clip to play when Play is pressed, or 
the list is started automatically by Arm Start Time. 

Looping Playlist (LOOP  [X] ) 
To loop the entire playlist after the last clip completes, check the LOOP checkbox at any time. 
Upon un-checking, the list will play to completion and then stop. 

Showing First Frame of CUED Clip (SHOW) 
When a clip is cued, the STOP button legend changes to SHOW.  Pressing it will display the 
first frame of the cued clip. 

Preparing Next Clip for Playback (NEXT) 
When a Playlist is stopped, click NEXT to prepare the next clip in the Playlist for playback.  
While the Playlist is running, NEXT will immediately begin playing the next cued clip in the 
Playlist. (The next clip may require several seconds to load and cue for a seamless transition.)   If 
the next event in the Playlist is a HOLD, the NEXT command will move to the Hold event, and 
video will display black. 

 

Jumping to Selected Clip (JUMP) 
Click JUMP to cue any selected clip for immediate playback; this permits jumping over 
intervening clips.  JUMP also allows clips that have already been played to be immediately re-
cued and played.  In this case, the Playlist will restart from the selected clip, and subsequent 
events will be re-played in sequence. 
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Automatic Scrolling to Currently Playing Clip (HOME) 
Click HOME to make the currently playing clip visible in the Playlist View window. If no clip is 
playing, then the currently-cued clip is displayed. This is helpful if you have manually scrolled 
elsewhere in a large Playlist. Once this is done, the display will also maintain the currently-
playing clip within the window, if EDIT is off 

Set Maximum Number of Items to Keep 
To set the number of played items to be retained in a playlist: 

Click OPTIONS>CONFIGURE from the Playlist View of the channel pulldown. Use the 
thumbwheel UP and DOWN scroll button to increase or decrease the number of clips to retain. 
The default value of zero will retain ALL Clips. 

 

 
Figure 24 - Channel Playlist Configure Screen 

Enabling As-Run Logging 
To enable As-Run logs, while in the Playlist View select OPTIONS >CONFIGURE from the of 
the menus within the Playlist window. Check the Enable As-Run Logging checkbox to enable 
As-Run logging. Uncheck the box to disable As-Run logging.  When enabled, a check mark will 
appear next to the As-Run log label, and files played by a playlist will be written to an As-Run 
log. As-Run logs are available only through FTP downloads; they cannot be viewed or printed 
from the server.  After logging into a server, select the ASRUN folder.  All logs are stored in this 
location, and have the extension “.arl”.  Refer to Appendix E – As-Run Logging for more details 
about As-Run logging functionality. 

Viewing, Editing and Archiving Playlists 
Playlists can be accessed via the server’s FTP feature, allowing several capabilities: 

• Lists can be backed up on a PC, and sent to another server. 

• Lists can be viewed and printed from the PC 

• Lists can be edited or created on the PC and uploaded to the server. 

Playlists are found in the MAXX-2420-EX’s FTP directory in the lists folder.  They are simple text 
files with the extension .lst.  Refer to Appendix D, Playlist Management for more information. 
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Editing Playlists 

Removing Clip from a Playlist 
To remove a Clip from a Playlist: 

• Make sure the clip to be removed is not PLAYING or CUED. 

• Position the cursor over the Clip and right-click. Select REMOVE from the pulldown 
menu. 

Removing Clips Above or Below the Selected Clip 
All clips above or below the selected clip can be removed unless a CUED or PLAYING clip is 
affected. These options will “grey out” if removal is not allowed for this reason. 

To Remove All clips above a selected clip: 

• Move the cursor over the clip to select it. 

• Right click the mouse and select Remove All Above from the pulldown menu. 
 

To Remove All clips below a selected clip: 

• Move the cursor over the clip to select it. 

• Right click the mouse and select Remove All Below from the pulldown menu. 

Inserting HOLD Into a Playlist 
The HOLD command inserts a hold (wait) event in a Playlist immediately before the selected 
clip.  The PLAY or JUMP command will restart a Playlist after it has stopped on a HOLD line.  
The HOLD command is also available in the Playlist Item Context Menu, accessed by right-
clicking in the Playlist item window.  If a programmed Start Time has been set and is armed, the 
Playlist will resume when the Programmed Start Time occurs. See Page 63 for instructions on 
setting a programmed start time. 

Appending a Playlist (FILE >APPEND) 
Make sure the EDIT checkbox is checked in the Playlist View window. Click FILE >APPEND 
from the Playlist View to bring up the list of available Playlists. Double-click on a playlist to load 
it.  It will appear at the end of the list after a label event that shows the name of the appended 
list.  This operation can be performed during playback, allowing a new playlist to be loaded 
without interruption of programming. 
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Changing Duration of Clips in Playlist 
Make sure the EDIT checkbox is checked in the Playlist View window. Position the cursor over a 
clip and right-click. Select EDIT DURATION from the pulldown menu. Enter a duration in the 
Duration window. The minimum duration is 4 seconds. The entry may be in one of these 
formats: 

• Hours, Minutes, Seconds and Frames entered as HHMMSSFF  
04300102 = 4 Hours, 30 minutes, 1 second, 2 frames  

• Hours, Minutes, Seconds and Frames entered as  HH:MM:SS:FF   
03:39:41:17 = 3 Hours, 39 minutes, 41 seconds, 17 frames  

• As a whole number along with the special characters H for hours, S for seconds, M for minutes. 7H 
would set 7 hour duration. 31m would set 31 minutes. 15s would set 15 seconds. 

 

NOTE: The Clip duration is affected only within the Playlist, for this event. The duration of the 
source clip is not changed.  Other events containing the same clip are not changed. 

Mapping GPO to Playlist Events 
The MAXX-2420-EX has twelve General Purpose Outputs, referred to as GPO 1 through 12.  Any 
of these can be programmed to go active at a pre-determined time, or offset, after the beginning 
of a Playlist clip.  An active duration can also be set, after which the output again goes inactive.  
In all cases, every output will go inactive when a clip ends.  By default, a new clip contains no 
programmed GPO output commands. Refer to Appendix A – Connector Specifications for details 
on electrically interfacing to the GPO lines. 

To Map a Playlist event to a GPO Line, Follow these steps. 

A. Select EDIT>CONFIGURE >GPO. The screen of Figure 25 is displayed. GPO 1 through 
12 are the 12 triggerable outputs. The checkboxes to the right of each selection represent 
channel 1, 2, 3 and 4. GPO 9 is shown with the trigger option pulldown expanded.  

a. Set the GPO of interest to PLAYLIST mode from the pulldown menu. 

b. Set the Channel to video 1, 2, 3 and/or 4 by checking the appropriate box to the 
right. Click APPLY to activate the settings.  

B. Check the EDIT checkbox in the Playlist View of the transport. 

C. Place the cursor over a Clip in a Playlist. Right click on the clip. Select EDIT GPO. The 
GPO Editor (Figure 26 ) appears. 

D. Enable the GPO of interest by checking the corresponding ENABLED checkbox. 

E. Enter an offset into the Clip to activate the GPO line in the Offset Field. The form of the 
field is Hours, Minutes, Seconds and frames. ( HH:MM:SS:FF ) 

F. Enter the Duration for the GPO to remain active in the Duration Field using the same 
format. Click APPLY to activate the changes. 
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Figure 25 - GPO Configuration Screen 
 

 

Figure 26 - GPO Editor 
 

Mapping GPI to Control a Playlist 
Playlists can be controlled with the twelve GPI Inputs. See Programming GPI Inputs on page 53. 
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Advanced Topics 

System Timing 
The MAXX-2420-EX is equipped for use with an external genlock signal as a timing reference.  

This causes all outputs to be synchronous with other video signals in a facility.   

Adjustment of Genlock Timing will fine tune this synchronization to compensate for 
differences in equipment and wiring. This global setting for all outputs allows timing to be varied 
by one line of video.  The Vertical (lines) setting rarely needs to be adjusted. If required, it would 
be adjusted so that the output of the first line of video happens concurrently with other 
contributing inputs.  The visible effect is that the picture will rise or fall by one line when viewed at 
the output of a timed video switcher, or on a genlocked monitor.  Note that this setting can cause 
VANC data to appear on different and possibly inappropriate lines. 

 

 

Figure 27 - Video Timing Adjustment 

The Horizontal (nsec) adjustment is used to set the precise timing of the start of the frame relative 
to the reference signal, in order to match with other contributing signals. The effect is not normally 
visible; extreme settings may result in a slight visible shift of the picture from left to right. 
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Using Embedded Audio 
The MAXX-2420-EX provides 8-channel embedded audio capability. Features include: 

• Synchronous 20-bit audio at a 48K sample rate.  Non-genlocked audio and other sampling rates 
are not supported.  

• The server records and plays Group 1 and 2 audio, (channels 1-8). Up to 16 channels of audio 
may be present in some HD-SDI streams.  

• In E-E mode, all embedded audio channels will pass through the server unaltered.  

• The user can select an audio source from the embedded audio, from the optional AXP-3 and 
AXP-4 multi-channel analog audio modules, or from the optional DXP-1 multi-channel 
AES/EBU digital audio module.  Mix-and-match among inputs is not supported. 

• Regardless of the source recorded, embedded audio is always inserted in the HD-SDI stream 
on playback, even when the primary audio output will be analog or AES/EBU audio. 

• User bits in the HD-SDI embedded audio stream are not supported. 

• 20 bit Dolby®-E is supported with 360 Systems’ Bit-for-Bit® technology. 

Using Audio Sample Rate Conversion 
A check-box is provided to engage built-in sample rate converters in the optional DXP-1 for 
incoming AES/EBU audio tracks, which are then converted to a 48K broadcast standard 
synchronized by video genlock.  

Sample Rate Conversion does not apply to analog or Embedded audio.   

The sample rate converters should be used in any of these cases: 

1. The incoming digital audio and video are not referenced to genlock. 

2. The sync reference is set to INTERNAL. 

3. The incoming digital audio is not at a 48 KHz sample rate. 
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Ganging Channels for Synchronized Playback 
Two video channels can be ganged together for frame-accurate playback. This may be used for 
key and fill material (either stills or clips), or multi-channel playout of presentations, such as 
synchronized matte backdrops on News Broadcasts, or multi-screen projection. 

The channels can be ganged in the following combinations: 

• Channel 1 controls Channel 2 and/or Channel 3 and/or Channel 4. 
• Channel 2 controls Channel 3 and/or 4 
• Channel 3 controls Channel 4 
 
Only one channel can be set as the master channel. 

To configure Channel Ganging Click EDIT >CONFIGURE >TIMING from the Main Menu. The 
video timing adjustment screen on page 69 is displayed. Two examples of this are: 

• To gang Channel 1 to channel 3, set CHANNEL GANGING MASTER to 1 and click the 
GANG checkbox on channel 3. 

• To gang Channel 3 to channel 4, set CHANNEL GANGING MASTER to 3 and click the 
GANG checkbox on channel 4. 

 

Using Ganging for Key-and-Fill or 3D Playback  
Channel Ganging is used for frame-accurate playback of stills animated sequences that have an 
alpha, or key, channel. These in turn are fed to a downstream keyer or video effects generator, 
to be combined with other video content. Manual or automated control of the Master channel 
is all that is needed to play both the key and the fill. The MAXX-2420-EX can also be used to 
play two synchronized channels for 3-D applications. 

Key and fill clips are associated by their names. The Key Clip must have the same name as the 
Fill Clip with a trailing underscore. Example: 

Fill clip name:  myfile 

Key clip name:  myfile_ 

There is no provision for automatic loading of similar named clips on more channels than the 
Master channel and the next higher numbered Ganged channel. Additional channels must be 
loaded manually, after loading the master channel. 

Proper key and fill operation requires two clips of identical length. This can be accomplished 
by editing with head and tail trim.   

Channel 3 is ganged to Channel 4 in the following example: 

When a clip is opened/cued on Channel 3, the server automatically looks for another clip with 
the same name, plus a trailing underscore.  If the clip is found, it is loaded on Channel 4.  The 
Channel 3 clip contains the “fill” material, while the Channel 4 clip contains the “key” (or 
alpha) file. 

An automation system could, for example, issue a VDCP Cue command to Channel 3 for a clip 
called “logo”.  Channel 4 would automatically be loaded with clip “logo_”.  A Still or Play 
command sent to Channel 1 would cause both Channels 1 and 3 to display the fill and key 
clips, respectively. 
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Note that the VDCP checkbox option to “show first frame” for a Cue command is ignored for 
channels in ganged mode.  The automation system must issue a Still command to Channel 1 to 
achieve this effect. 

Ingesting a TARGA file via FTP automatically creates a key clip and a fill clip, each a single 
frame in length.  For example, if file “xyz.tga” is transferred to a server via FTP, then a pair of 
single-frame clips is created:  “xyz” and “xyz_” containing the fill and key material. 

Combined Video and Graphics Capabilities 
MAXX 2420-EX includes graphics import capability, enabling the server to function as both a 
graphics still-store, and an animation playout server. Its four outputs give it the power to 
provide key-and-fill material along with two additional video feeds simultaneously.   

The server supports FTP import from most graphics systems, including Photoshop®, After 
Effects®, Final Cut Pro®, Xpress Pro™, Liquid Edition and Vegas Video. 

Importing TARGA Graphics Files 
The server can recognize and ingest single-frame TARGA files via FTP.  TARGA files have a .tga 
extension, and may contain an alpha (or key) channel.  During transfer, the server will split the 
TARGA file into a Fill frame, and a Key frame if it exists. If no alpha layer exists, a white field is 
created.  These will be converted to high-resolution files, one frame in length.   

For example, if an original file is named Logo.tga, the files created will be named Logo.mxf (the 
fill file) and Logo_.mxf (the key file).  Note the trailing underscore “_” added to the file name of 
the key.  This allows the TARGA file to be used for key and fill applications when channels 2 
and 3 are ganged together.   

The resolution of a TARGA image should be 1920 x 1080 for use in 1080i format, or 1280 x 
720 for use in 720p format. If the original TARGA image is not of this resolution, the server will 
re-scale it, possibly introducing some dimensional distortion.  The bit depth of the files must be 
24 or 32 bit. The server does not support Targa sequences, only single frame graphics. 

Animation Import (Uncompressed .mov files) 
From the server’s standpoint, an “animation” is a clip with a minimum length of two seconds. 
Clips used for sequential (back-to-back) seamless playback must be a minimum of four seconds 
long. A separate Alpha channel may or may not be present.  Any graphics workstation capable 
of exporting files supported by the server can make transfers to it via FTP.  If an alpha channel 
is present, the naming conventions of the Key/Fill Mode apply: the file name for the key video 
is the same as the filename for the fill video with the addition of an underscore character ( _ ).  
Many software programs have the ability to create content compatible with the server, 
including Final Cut Pro®, Avid® Xpress, Liquid Edition, Vegas Video; and Adobe® After Effects®, 
Premiere® and Photoshop®.  

Animation sequences to be sent to the MAXX-2420-EX should be saved in QuickTime 
Animation format. The image size should be 1920x1080 interlaced (with Top Field First) or 
1280x720 progressive. An alpha channel may be present.  The field rate should be either 59.94 
or 50 Hz. 

Note that when Exporting from some NLEs such as Final Cut Pro, you must Export to a storage 
volume that is considered a Macintosh volume in order to create compatible .mov files that are 
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over 2GB. This can be an issue when attempting to Export directly to network storage 
locations.  In practice this amounts to a maximum clip duration of about 4 seconds. 

There is an indeterminate time limit somewhere above 1 minute that is dependent on the 
amount of detail in the material. (This is program dependent because it is on the post-
compression side of the transcoding process.) 

The resulting .mov file may be sent to the server by FTP, logging in as user “anonymous” 
or “ftp”. No password is required. After the transfer completes, the server will render (encode) 
the .mov animation sequence into a pair of JPEG-2000 clips (key and fill) that are playable on 
the server. This is a somewhat time-consuming process, so it takes place in “background 
mode”. The GUI status bar indicates the clip being processed. When finished, the clip name 
will appear in the GUI clip list, ready for playback. 

 

Still Frames 
A single-frame clip (a “still”) may be inserted into a playlist.  The length of a still will appear as 
one frame in the clip list.  When a still is encountered, the playlist will pause and hold the still 
image until a Play command is issued, at which point the playlist will continue to the next clip 
in the list.  When using the GUI, the space bar (a keyboard shortcut) will also advance the 
playlist.  Stills may be placed anywhere in a playlist.  In fact, a playlist may be entirely 
composed of stills.   

A still frame clip in a playlist can have a duration assigned to it (See page 67 ).  It will then play 
for that duration and the list will continue automatically. 

Stills are created when TARGA files are ingested. (See page 79 for a description of TARGA file 
ingest.)  It is also possible to create a still frame by editing any clip. When editing the clip, 
position the transport on the desired frame and set both the In and Out points to this frame.  
Save the clip, or Save As to a new clip name. The selected frame will be displayed when the 
clip is played in the Playlist. 
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FTP File Transfers 
The MAXX-2420-EX connects over Gigabit Ethernet using an RFC-1359 compliant FTP server. File 
transfers to and from the server are managed from an FTP client file transfer program running on a 
Windows® or Macintosh® computer.  This provides a rapid way to execute drag-and-drop file 
transfers; it can also manage many servers at once and does not tie up the server GUI, which may 
already be in use. Table 2 indicates the supported FPT client list.  
 

FTP Client Version Platform 
Flash FXP 3.2.0 WINDOWS XP, WIN2K 
DOS FTP 5.1.2600 WINDOWS XP, WIN2K 
WS FTP 5.08 WINDOWS XP, WIN2K 
Internet Explorer 6.0.2900 WINDOWS XP, WIN2K 
Fetch 5.2 MAC OSX 
CyberDuck 2.7.3 MAC OSX 

 
Table 2 - Supported FTP Clients 

 
FTP programs may also be used to move recorded or edited material between a server and 
Network Attached Storage (NAS) or a DVD-ROM library. 

From a networking or system-integration viewpoint, the server appears as a normal FTP server 
in any size network, with the exception that it may only receive video files that are compatible 
with the server. 

The server is designed to be used in a private dedicated video network.  A firewall with 
VPN capability must be used in systems that require internal security or connection to 
public networks. 
Consult with a network security specialist for guidance on the best hardware, 
programming and practices for your facility’s requirements. 

Gigabit Ethernet Cable Quality 
The high data rates generated by Gigabit Ethernet require high-quality cable designed for this 
application.  Low-quality network cables can result in high error rates and lower transmission 
speed.  For Gigabit operation, standard CAT-5 cable should be used only for very short cable 
runs. 

New Category 5e (enhanced) cables ensure maximum transfer rates, and should be used as the 
minimum standard.  Category 6 cable is a good choice for applications where longer cable runs 
are required.  

Configuring the FTP Interface 

Before logging in to the server’s FTP server, the network must be configured according to the 
local network topology. This is primarily a matter of setting a static IP address or configuring  
the server to use DHCP to obtain an IP address from a DHCP server. Refer to page 54 for 
details on configuring the network settings. 
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When connecting directly to a PC or Laptop, configure the server as IP address 192.168.1.3, 
netmask 255.255.255.0 and disable DHCP.  In the PC, double click on the Local Area 
Connection Icon in the system tray or in the Network and Dial-Up Connections in the Control 
Panel. In the Local Area Connection Status dialog, click on Properties. Click on the item 
“Internet Protocol (TCP/IP)” and click on Properties again. In Local Area Connection Properties, 
turn off “Obtain an IP Address Automatically“ by selecting “Use the Following IP Address” and 
set the address to 192.168.1.2, netmask to 255.255.255.0. 

No hardware settings are available or needed.  The NET-1 port automatically negotiates port 
speed and configures transmit and receive connections, and does not need a “crossover” cable 
when connecting directly to a PC. 

The actual transfer rate depends on the format of the files being transferred, and the number of 
video streams being played or recorded.   

Logging in to the server FTP Service  
The server allows only for two types of login based on the username supplied. One is 
“anonymous”, the other is “mxf”. The difference is that the files will be displayed and served in 
the .mxf format when logging in as mxf, or in the 360 Systems .vfc format when logging in as 
“anonymous”. Files of either type can be uploaded regardless of the login method, however it 
is best to log in as mxf to load  .mxf files or anonymous to load .vfc files.  This way the FTP 
client will see the same file extension as the file being loaded, so that if the FTP client is set to 
warn about overwriting existing files the file extensions will match. 

Using one of the FTP clients shown in Table 2: 

• Enter the username “mxf”, and the password “mxf”, or 

• Enter “anonymous” as the user name or check the “anonymous” checkbox on the login 
screen. If a password is required it can be any real or fictional email address.  

When the FTP client is connected, it will display the Clips in the main directory and all of the 
sub-folders. Clips can be uploaded, downloaded, deleted and renamed using standard FTP 
client commands.  Clips in the subfolders can be displayed by entering those folders.  Consult 
the documentation for your FTP client for information on changing folders. 

FTP Transfer Rates 
Transfer rate (transfer time relative to clip length) depends greatly on the current operational 
demands on the server.  This includes the number of channels that are being used, whether 
there is recording taking place, the bitrate of the video, and the number of VANC data lines in 
use. 

Secondarily, the network itself and the source of FTP data can be limiting factors in some cases.  
The following rates assume a dedicated network with limited additional traffic, a high 
bandwidth FTP source, and a video bit rate of 75 Mb/s with 1 VANC line. 
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Transfer Time for 1 minute of video 

Workload Upload to MAXX Download  
(or MAXX-to-MAXX FXP transfer) 

IDLE 14 seconds (45.0 MB/s or 360 Mb/s) 28 seconds (22.5 MB/s or 180 Mb/s) 

1 Channel Playing 14 seconds (45.0 MB/s or 360 Mb/s) 28 seconds (22.5 MB/s or 180 Mb/s) 

3 Channels Playing 15 seconds (39.4 MB/s or 315.2 Mb/s) 45 seconds (14.0 MB/s or 112 Mb/s) 

1 Record, 2 Play 17 seconds (37.0 MB/s or 296 Mb/s) 44 seconds (14.3 MB/s or 114.4 Mb/s) 
 

Multiple Simultaneous FTP Operations 
FTP client programs that allow multiple simultaneous data transfers should be set to allow only 
one data connection at a time.  

While it is possible to log in from multiple clients, it is only acceptable to perform multiple file 
transfers when the system is idle or playing or recording on a single channel.   

File Sizes Reported in FTP Listing 
The size of a clip reported in the file listing depends on the file type you are going to download 
from the server.  In any case it is a close approximation of the amount of data that will be 
required to store the downloaded file. See the discussion of the .mxf and .vfc file types. 

Overwriting Files 
It is the responsibility of the client application (Windows Explorer, FlashFXP, etc) to ask the 
user if they want to overwrite a file. 

Note that some types of files (such as .mov and Targa) change their file extensions when they 
have been transferred into the server.  In these cases, the FTP client cannot warn of a file 
overwrite. It is important to take extra care when using these types of files not to overwrite 
necessary files. 

Interrupted and Resumed Transfers 
If a transfer is interrupted (for example, by a dropped connection) the transfer must be restarted.  
Resumption of a partial transfer is not possible. 

Transfer of Edited Segments 
The server sets MARK-IN and MARK-OUT points in a clip as “edit pointers.”  For all edit 
operations within a given server, these pointers produce “virtual edits” that save disk space, 
and the time it would take to re-write the marked region as a new file. 

When transferring clips via FTP, depending on the method used, either the material between 
the edit points or the entire clip is transferred.  
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When transferring files as mxf, only the material between the edit points is transferred. This 
means that: 

• Transfer of a file with head and tail points set will remove portions before the head and 
after the tail.  The original length of the file cannot be referenced in a restored copy. 

• Transfer of a master file and (non-overlapping) subclips of that file will result in 
duplication only of the material defined by the subclips. 

• The size of a clip reported in the file listing is the amount of video and audio data that 
will be transferred based on the settings of the In Point and Out Point. 

• To maintain the identity of the transferred clip, the time code references for its Mark-
In/Out points are maintained, as shown in Figure 28. 

  

                  
Figure 28 – Result of an MXF file transfer 

 

When transferring files as .vfc, all of the material for the entire file is transferred. This means that: 

• Transfer of a file with head and tail points set will include portions before the head and 
after the tail.  The original length of the file can be accessed in a restored copy. 

• Transfer of a master file and all subclips of that file will result in duplication of all the 
material in the master and the subclips.  The original length of the file can be accessed 
in any restored subclip.  A 1 minute subclip of a 1 hour file will require the same 
amount of space as the 1 hour original.  Backing up both of them will require twice as 
much storage as was used on the original drive.  Restoring them will require twice as 
much space on the server as well. 

• The size of a clip reported in the file listing is the amount of video and audio data 
included in the entire clip, regardless of the settings of the In Point and Out Point. 

• To maintain the identity of the transferred clip, the time code references for its Mark-
In/Out points are maintained, as shown in Figure 29.  

When transferring edited material, keep in mind that you are making copies of the data on the 
target device.  While subclips that reference the same video content on the original recordings 
take up minimal extra disk space, they could take considerably more space on the target 
storage.  
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Figure 29 – Result of a VFC file transfer 

 

Bit Rates of Transferred Files Reported in the Clip Navigator 
JPEG2000 as implemented in the MAXX-HD is a variable bit rate compression technology.  
What this means is that the actual bit rate (amount of video data) that is created is dependent 
on the level of detail in the images in the video frame being encoded. 

The Video Compression Max Bit Rate setting is only a limit.  The actual bit rate is determined 
by the encoder on a frame by frame basis.   

When a clip is first recorded, the GUI displays the Max Bit Rate value that was in effect when 
the clip was recorded. 

Files that are transferred as .vfc files maintain this value.   

Files that are transferred as .mxf do not carry this value, so the GUI will display the actual 
calculated average bit rate of the file as a function of its size relative to its duration.  Therefore 
it is normal to see variation between the original and a transferred copy of the file. It does not 
mean that the content of the encoded video has been changed in any way. 

Supported File Types 
MAXX recognizes media file types by their file extension.  It is important that the file extension 
properly identifies the file content.  Attempts to send a file in one format but masquerading as 
another due to a wrong file extension may result in undefined behavior.  

It is also true that file extensions such as .mxf and .mov can contain many different formats of 
video and audio. The MAXX will only accept files that contain compatible formats as defined 
below.   

Always test file import before depending on it for broadcast.  Some formats allow wide 
variation in the structure of files, and the parameters used in the video compression.  MAXX-
HD will not accept all possible variations; always test files from new sources before going on 
air. 
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The following formats are supported: 

JPEG-2000 (.mxf) 
JPEG-2000 files wrapped in the .mxf format.  The mxf type is Operational Pattern OP1a.  The 
audio is 24-bit 48KHz PCM (uncompressed) in 8 individual tracks. 

These files are compatible with the Edius non-linear editing program from Grass Valley.  See 
the next section for more information. 

JPEG2000 format .mxf files from the Grass Valley Infinity camcorder are also compatible. 

JPEG-2000 (.vcf) 
JPEG-2000 files are also available in .vcf, a proprietary 360 Systems format.  This is a very 
simple collection of the native component files.  It has some minor performance advantages 
over .mxf and can be useful in certain applications.   It is not recommended in applications 
where there are many subclips created as the files contain all of the data regardless of the 
settings of the head and tail pointers.  A four second clip taken from a 1 hour file will contain 
the entire hour of data. 

In automation controlled systems that create subclips by reference to a single master file, this is 
the preferred file type to use for mirroring content between servers or to backup storage.  It is 
also the format used by Telestream Flip Factory to transcode files to and from the MAXX server. 

The performance advantages are only significant when the system is being used near its 
maximum capacity (of both channel use and clip bitrate) and FTP transfers are required.  While 
.mxf is interleaved, .vfc carries the video, then the audio, then the ancillary data.  This means 
that only one file is read or written at a time, and the processor does not need to deal with the 
interleaving of the data. 

MOV (.mov) 
MOV-wrapped graphics can be imported and rendered for playback as JPEG-2000 files. 

Animation sequences to be sent to the MAXX-1200 should be saved in Uncompressed 
QuickTime format. An alpha channel may be present.  Clips may be up to 1 minute in length. 
(Note that this is program dependent, video with low detail or partial coverage (such as lower 
thirds) may be able to run longer.) 

 

IMPORTANT 

When Exporting from some NLEs such as Final Cut Pro, you must Export to a storage volume 
that is considered a Macintosh volume in order to create compatible .mov files that are over 
2GB. This can be an issue when attempting to Export directly to network storage locations.  In 
practice this amounts to a maximum clip duration of about 5 seconds. If this is exceeded the 
file will fail during the render when sent to the MAXX HD. 
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Use File>Export>Quicktime Conversion (this is specific to Final Cut Pro, other programs may 
differ). 

Settings: 
Frame Rate = usually can be Current to reflect the timeline setting, but the rate for 720p is 
59.94, the rate for 1080i is 29.97 with Field Dominance set to Upper (Odd). 

(Note that some Quicktime codec user interfaces use fps, which may mean either fields or 
frames.  If you ever have issues with run time being halved, use 29.97.  If run time is 
doubled, change to 59.94.) 

Codec = None 
Millions of Colors + 
Best Quality 
Dimensions 1280x720 for 720p operation, 1920x1080 for 1080i operation. 

Sound Settings: 
Linear PCM 
Stereo (L,R) 
Rate = 48 KHz 
Sample Size 16 Bit 
Quality = Best 
Big Endian (leave Little Endian unchecked) 

 

TARGA (.tga) 
24 or 32 bit format (16 bit format is not supported.) During transfer, the TARGA file will be 
split into a Fill frame and a Key (Alpha) frame.  These are saved as .tga files, each one frame in 
length.  The clip name for the fill frame is the base name of the .tga file, while the key frame 
has this name with an appended underscore character. The resulting files will be available as 
MXF files for subsequent FTP transfer. 

 

Playlists (.lst, .txt) 
A server playlist is a text-based file residing in the ‘lists’ directory.  Playlists can be created off-
line and transferred to the server using FTP.  See page 139 for further information on playlist 
file editing and management.  

 

As-Run Logs (.arl) 
As-Run logs are available as a document of content actually played.  They may be extracted 
through FTP transfer.  See page 65 for further information on using As-Run logs. 
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Using MAXX-HD with the Edius NLE 
Edius is a non-linear video editing program for PC computers available from Grass Valley 

Group.  It is a full featured editor including titling, video effects, audio processing and 
compatibility with a wide variety of video formats.  MAXX-HD files can be placed directly on the 
timeline without any transcoding, and rendering time for unmodified video sections is extremely 
fast as no transcoding is required.  Files in other HD and SD formats such as DVCPro can be 
placed on the time line and output as MAXX-HD compatible .mxf files ready for transfer to the 
MAXX-HD. 

Exporting and Creating a Preset 
The Export process is applicable regardless of how Edius is configured. (Later we will discuss 

how to configure the Edius timeline to operate directly in JPEG2000.) 

The Export button is at the lower right of the preview window. 

Clicking on it produces a drop-down menu: 

 

 

 

Select Print to File. 

The F11 key is a shortcut for this. 
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The Select Exporter Plug 
In dialog appears. 
 
 
In the window on the left, 
select Infinity. 
 
 
In the Exporter section in 
the window on the right, 
select Infinity JPEG2000. 
 
 
 
 
Select Export Between In and Out if desired. This allows exporting of only the portion of the 
timeline between the In and Out markers.  
 
Select Enable Conversion.   
 
Click on the arrow next to Advanced to expand the dialog. In the Advanced section, set up the 
parameters as shown in Figure 30 for 1080i, or Figure 31 for 720p. 
 

 

Figure 30 – Plug-In Selection and 1080i Configuration 
 



 

MAXX-2420-EX Owner’s Manual Page 83 

 

Figure 31 – 720p Configuration 
 

Click on the Disk icon at the bottom of the Select Exporter Plug In dialog (see the bottom of 
Figure 30) to save the settings as a Preset.  Enter the desired Preset Name and Description.  The 
recommended bit rate is 75 Mbps.  The Audio Format is 24bit/8ch, even if your source is 16 bit 
or fewer channels.  

                  

 

If most of your output will be for the MAXX-HD, click Save as Default to set this as the default 
configuration for Export (again refer to the bottom of Figure 30). For more information on the 
various parameters, refer to the Edius documentation. 

Click Export to start the export process.  The dialog shown in Figure 32 will appear. 
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Figure 32 – Export Dialog 
 
 
Select the Folder option and click Browse to specify 
the output directory.  Enter a Clip Name. Leave 
Playlist selection set to “Same as clipname”. Click 
OK to start the Export. 
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For this example the output 
directory was 
F:\HDVideoFilesOn13T\Edius. 
After the export, two folders are 
created there, Clips and 
Playlists.  The Playlists folder is 
unimportant; the Clips folder is 
where the output folders will be 
found 
 
 
 
 
 
Each clip has its own folder.  In 
this example, the Clip name 
was ExportExample.  The first 
time this name is used, a folder 
is created with the name 
ExportExample_0001.icf.  When 
a name is used again, the 
number is incremented, as can 
be seen at right.  
 
 
 
 
Inside each clips folder are 
several files.  The .mxf file is the 
one that will be sent to the 
MAXX-HD.  It contains both the 
video and audio. The other files 
are not used. See the section on 
FTP transfer on page 74 for 
information on transferring the 
MXF file to the MAXX-HD. 
 
Files from the MAXX-HD can be transferred to the Edius system via FTP.  These files can then be 
included on the Edius timeline like any other video file.  See the Edius documentation for 
information on importing clips into the editor. 
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Creating a Project and a Project Preset 
When using Edius to edit video primarily sourced from the MAXX-HD, there is no question that the 
project parameters detailed here should be used.  However, if you are primarily using material 
from other sources, or delivering to other formats, it may be more efficient to use other Project 
formats and simply rely on the Export process to output to JPEG2000.  For mare information on 
choosing a Project format and specifics of Project parameters, refer to the Edius documentation. 
 
To create a Project Preset or start a new Project, select New from the File menu, then select Project 
from the fly-out menu under New (or, use the key command Control+N.) 
 

 
 
A single Project Preset is shown in the dialog above, if you create another one it will appear there 
as well. When starting a new project, you would simply double click on the Project Preset icon.  
To create a new Project Preset, Select New Preset and then choose the parameters shown in the 
following diagrams to create a 720p or 1080i Project Preset. 
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Figure 33 – 1080i Project Configuration 

 

Figure 34 – 720p Project Configuration 
Note that the VA track includes a stereo audio track, so the 6 “A” tracks make up the remainder 
of the 8 tracks used by MAXX-HD.
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Network Time Protocol 

Automatic Date/Time Updates 
When using server play-lists in broadcast applications, an accurate record is often needed of 
what was played and when.  The server’s As-Run logging feature creates such a record, time 
stamping each played clip using the machine’s internal date/time clock.  Very accurate time 
stamping can be achieved by synchronizing the server’s clock to an external time base that is 
referenced to Coordinated Universal Time (UTC). 

This is accomplished using the Network Time Protocol (NTP) to interrogate time servers 
through a network connection.  A time server could be an in-house computer or dedicated time 
server that is equipped with a GPS receiver, or a radio receiver locked to signals from the NIST 
radio station WWV.  Alternatively, public time servers may be used which are accessible 
through an Internet connection. 

Connecting to the Internet 
To obtain automatic date/time updates from the public time servers on the Internet, you will 
need to provide the server with Internet access.  Generally, servers would be connected on a 
secure high-speed local area network, with any Internet connection going through a router with 
an integrated firewall.  The Network Time Protocol uses TCP/IP port number 123, so be sure 
the firewall is configured to allow access to this port per Figure 35. 

 

Figure 35 - NTP Network Block Diagram 
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Configuring NTP 
The server GUI is used to set the time zone and to enter the networking parameters.  The local 
GUI must be used, as these configuration screens are not available on the Remote Workstation 
Interface.  

Selecting the Time Zone 
Starting at the main menu bar, Click Edit >Configure >Date-Time screen.  When “Automatic 
Updates” is not checked, the Region and Zone lists are enabled.  Select your region and then 
the zone within that region.  There may be more than one way to your zone; America/New 
York, for example, is the same as US/Eastern. Click the APPLY button to activate the settings, 

 

After changing the time zone a Quick Restart must be performed before changes become 
effective. 

 
 

Figure 36 - Date/Time Configuration Screen 
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Entering Network Parameters 
From the GUI’s main menu bar, click EDIT>CONFIGURE>NETWORK. The following screen 
appears. Make sure the basic network parameters have been entered. 

 

Figure 37 - Network Configuration Screen 
 
Disable Network:  uncheck 

Host Name:  (Any name will suffice, but since this name appears on each line of the server’s 
diagnostic logs, it is a good idea to keep this short.) The name should also be unique from other 
devices on the network. 
 
If “Use DHCP” if not checked, then enter a fixed IP address compatible with your local subnet.  
For example, 

IP Address:  192.168.1.20 
Net Mask:  255.255.255.0 
Default Router: 192.168.1.1 
 
The Name Servers and NTP Servers fields provide the information needed to reach the public 
time servers. The NTP Servers field contains a list of time servers, either by numeric IP address, or 
by site name (URL).  Entries are separated by spaces. 
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The nonprofit Internet Systems Consortium, Inc. (ISC) maintains sites that automatically return 
lists of public time servers to an NTP client such as the server.  Hence, the NTP Servers field is 
initially filled in with the URL’s for these sites (0.pool.ntp.org, for example).  Of course you can 
overwrite this list with the addresses of specific time servers you may want to use.  However, if 
you try to clear the NTP Servers field it will be reset to the default list. 

 

Note: When URLs (non-numeric site addresses such as pool.ntp.org) are used in the NTP Servers 
field, the IP address of at least one DNS (Domain Name server) must be provided in the  
Name Servers field.  Typically, this address is supplied by your Internet Service Provider.   

 
These name servers translate URL names into numeric IP addresses needed to access the sites 
in question. 

 
When using a GPS-based time server which is connected directly to a local area network, enter 
its numeric IP address (such as 192.168.1.60) into the NTP Servers field, leaving the Name 
Servers field blank. 

 
Also, if you know the numeric IP addresses of the public or corporate time servers on the 
Internet, you can enter these addresses, separated by spaces, in the NTP Servers field, leaving 
the Name Servers field blank, since there would be no URLs to be resolved.  

 

Note:  Not all Network Time servers allow unlimited public access. Refer to www.ntp.org for 
more information.   

 
 

Click the APPLY button to save your changes. 
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Automation Control 
 

MAXX-2420-EX’s serial control inputs connect with many broadcast automation systems, 
instant replay panels, video switchers, and remote control devices.  

For compatibility with simple controllers and push buttons, the server also provides 12 GPI 
(contact closure) inputs, and 12 programmable command outputs. 

Remote Serial Control 
The server’s four 9-pin RS-422 serial control inputs permit control of their associated video 
channels.  The following serial protocols are accepted:: 

• VDCP 
• BVW 
• ODETICS Extensions to the BVW protocol 

 

 

Figure 38 - Rear Panel Detail of Serial Port Connectors 
 

CH1 - Channel 1, also referred to as COM1 
CH2 - Channel 2, also referred to as COM2  
CH3 - Channel 3, also referred to as COM3 
CH4 - Channel 3, also referred to as COM4 
 

 
With VDCP, each port can also respond to channel ID numbers that are equal to, or multiples 

of, its base number.  For example, channel 1 will also respond to 5, 9, 13, etc.  This can be helpful 
when an automation system needs to control a number of servers at once  

The server’s multiple serial ports allow simultaneous connection of an automation controller 
and a desktop editing controller.  For example, one could attach an edit controller to Channel 1 for 
record, playout, and editing; while an automation controller on Channel 3 manages play-to-air 
operations.  Alternatively, a single controller could control the operation of all server channels.  A 
single VDCP controller will commonly control multiple server channels. 

It is possible for a single VDCP controller to control multiple server channels through one 
physical serial port.  This is up to the design of the controller; it cannot be configured in the server 
if the controller does not support it.  When using a single port to control more than one channel, 
be sure the Assigned Serial Ports option is unchecked.  Do not attempt to use a different serial 
port to control one of the video channels that is under multichannel control. 
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Controller Priority 
Only one serial controller can control a given video channel at a time. In general, the first 

controller to gain control of a video channel will have exclusive command.  This prevents 
conflicting instructions that would cause unexpected behavior.  The only exception is that the 
graphic user interface can immediately take control of a channel by deselecting Serial Control in 
that channel’s dialog window. 

External controllers are prohibited from taking control away from the GUI. The Serial Control 
box must be checked in the channel dialog window before a remote control device can 
communicate with that channel. 

Configuring the Automation Interface 
Setting the automation protocol for a video channel 

Each video channel can be configured independently for VDCP or BVW protocol. 

To map a protocol to a channel, Click EDIT >CONFIGURE >SERIAL PORTS from the main 
pull-down menu. The screen of in Figure 39 is displayed. Use the PORT pulldown to select 
COM1, 2, 3 or 4; these map to Video channels 1, 2, 3 and 4.  

• Select VDCP to map the port to VDCP protocol 
• Select BVW to map the port to BVW and ODETICS protocols 

 
Note that the ODETICS protocol is layered with the BVW protocol, and that it supports clip 

names of up to eight characters only. Clips with longer names will not be displayed by an Odetics 
controller and will not be accessible.  This includes the demo clips shipped with the server; see the 
section on page 57 to rename the clips to allow their use for testing. 

VDCP operation can allow control of a channel by ID number from a different numbered 
serial port, while BVW and Odetics protocol control only the channel number corresponding to 
the number of the serial port in use.  When using both protocols, take care to not allow a VDCP 
controller to address a channel that is controlled by BVW/Odetics on another serial port. 

If necessary turn on “Assigned Serial Ports” in VDCP Options – this will force VDCP to 
control the channel corresponding to the serial port it is connected to regardless of the channel ID 
in the control messages.  This allows flexible assignment in control systems that limit choices of 
channel IDs, and also (with some systems) can reduce the possibility that, if the server is 
disconnected for any reason, the controller might have to be reset to resume communication. 
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Figure 39 - Serial Port Configuration Screen 

 

Setting the Automation Source Directory 
By default, automation equipment will access the Home or Root directory as a source of clips. 
The directory accessed by automation equipment can be set for each port as follows. 

Select the port to be used (COM1, COM2, COM3 or COM4). 

Click on the FOLDER icon in the PATH field of the Serial Port Configuration Screen. Navigate 
to the folder to be accessed by automation equipment. 

It is recommended that for most applications only the root directory be used, and the 
automation system be relied on for file management rather than the server.  Automation can 
only see the clips that are in the assigned Automation Source Directory.  There are two classes 
of applications for folders in conjunction with serial control: 

 

Limiting the number of clips accessible to automation or remote controllers. 

• Some controllers have limited capacity for clip display and selection. Using a folder to 
present only the currently needed clips can streamline operation. 

• Content can be prevented from being aired but still be readily accessible.  Content can be 
ingested at any time and made available to air by moving it into the Automation Source 
Directory.  

•  “Archived” material can be held in organized folders, then copied into the Automation 
Source Directory as needed to air. The copies can then be deleted after airing without 
affecting the archived copy. 

• Content for different purposes can be grouped in folders, and selected by changing the 
Automation Source Directory.  
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Segregating material for different broadcast channels 

• Content can be placed in a folder for each channel, and played out by separate automation 
systems or controllers.  Each channel can run completely independently – there can be 
duplicate file names with different content, and the opportunity for airing content on the 
wrong channel is greatly reduced.   

• Content that is common to both channels can be copied into both directories. When this is 
done in the GUI (as opposed to FTP transfer) the copies reference the same data so they are 
available immediately and take no additional disk space. 

Other Automation Options  
As illustrated in Figure 39, a number of check boxes are provided that control how the server 
will respond to certain VDCP commands.  Once set, these options remain selected when the 
server is turned off, and until changed by the user. 

NOTE: The following options will apply to all four video channels. They cannot be individually 
configured for each video channel.  Except where noted, they apply only to VDCP operation. 

Cue Shows 1st Frame 
Upon receiving a Cue With Data or a Play Cue command, the server will cue the clip then jog 
to and display the first frame of video. (This also applies to Odetics protocol.) 

Cue with Offset (vs. Timestamp)  
When checked, the time code for the clip becomes “zero-based” with reference to the head 
point.  To move to the head point of the clip, the automation controller would send a time 
code value of 00:00:00:00, regardless of the clip’s original time stamp.  When unchecked, the 
server will calculate time code position based upon the time stamp from the first frame of the 
unedited clip.  Note that this only affects the operation of the serial port, it does not change the 
way the server displays time code in the GUI. 

Variplay 1X Equals Play 
The server will interpret a Variplay 1x command as a Play command. (This also applies to 
Odetics protocol.) 

Variplay 0 Equals Pause 
The server will interpret a Variplay 0x command as a Pause command. (This also applies to 
Odetics protocol.) 

Report Play (vs Still) At End 
When the end of a clip is reached, the server will report Play to the automation controller, 
instead of Still. 

Ignore Preroll Commands 
A minimum 4-frame pre-roll is required to allow the server time to respond to serial 
commands.  See the documentation for your controller or automation to find out how to set the 
preroll value. Due to various ways preroll commands are implemented in different systems, it 
may be sufficient to check only this box. A setting of 4 frames in the automation controller will 
then work correctly. 
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This option is very seldom used; it allows preroll commands to be ignored and assumes that 
the operational preroll is 4 frames. Do not check this unless you experience problems with 
frame accuracy on recordings and playback transitions.  Start with a setting of 4 frames on the 
automation system and adjust until you achieve proper timing. 

Auto E-E 
Toggles Auto E-E mode (input monitor) on/off. 

Assigned Serial Ports  
VDCP protocol provides for altering the mapping of Serial Port to Video Channel via control 
commands. Checking this option will lock the Serial Port to Video Channel ordering.  

• When checked, any command received on a particular serial port will be used to control 
the like numbered video channel.  This means that automation systems that use fixed or 
limited VDCP ID numbers can use any output to control any channel of the server. 

• With this option checked, there is no requirement for a Port Open command to allow the 
automation to control the channel.  With some systems, this can negate the requirement to 
restart the automation system when bringing the server online. 

• Do not check this option when using controllers that communicate with multiple channels 
over a single serial port.  

• Do not use this option with DNF Controls products. 
 
Communication Port Parameters 

The serial data transfer parameters for the server are fixed and cannot be changed.  These 
characteristics are common to all automation controllers: 

 

Baud Rate 38.4 K Baud
Start Bits 1 
Data Bits 8 

Parity Odd 
Stop Bits 1 
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Tested Automation Controllers 
The server has been tested by 360 Systems and the manufacturers of equipment listed below, 
and found to operate correctly.  This list is not comprehensive, and the inclusion or absence of 
a product does not indicate a preference for any make or model.  Operational variations do 
exist between makes and models.   

 
Manufacturer Controller Protocol Notes 

HARRIS AUTOMATION  ADC-100 VDCP ALL HARRIS CONTROLLERS SAME 
SUNDANCE FAST BREAK VDCP  
NVERZION EMC-NT  VDCP  

CRISPIN CORP. SYSTEM 2000 VDCP  
FLORICAL AIR BOSS VDCP  

VCI SOLUTIONS (DTG)  AIRO VDCP  
HARDATA HDX VIDEO ODETICS  

IBIS ITA VDCP  
PEBBLE BEACH SYSTEMS ANEMONE VDCP  

PROBEL MORPHEUS VDCP  
PHAROS PLAYTIME VDCP  
AVECO ASTRA VDCP  

 

Tested Remote Control Panels and Switchers 
360 Systems servers have been tested by 360 Systems as well as manufacturers of remote 
control devices and video switchers listed below, and found to operate correctly.   

 
Manufacturer Controller Protocol Notes 

ROSS VIDEO SYNERGY® SWITCHERS VDCP  
ECHOLAB OPERA SWITCHERS VDCP  

DNF CONTROLS∗ 4000-CL VDCP ALSO USED WITH DNF SHOT BOX 
DNF CONTROLS 300-SSM P2 BVW-75, ALSO ODETICS PROTOCOL 
DNF CONTROLS D-MAT VDCP ALSO ODETICS WITH D-MAT-O 

ASH VALE  SM-2 P2 SLOW MOTION CONTROLLER 
BUF VTC-4000 P2 BVW-75, ALSO ODETICS PROTOCOL 
BUF SPOT VDCP ALSO ODETICS PROTOCOL 

LANCE DESIGNS TDC-100 ODETICS USE INT MODE 
HI-TECH  SYSTEMS ACTIV CART BOX VDCP ALL VDCP PRODUCTS SAME 

 
 

                                                 
∗ Uncheck “Assigned Serial Ports” in Serial Port Options when using any DNF Controls product. 
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Remote Workstation Interface 
 

The Remote Workstation Interface is a software application that provides control of the server 
from PC workstations located within a facility. A remote workstation can access one or more 
video channels of the server to perform ingest, playback, trimming, playlisting, traffic 
operations or monitoring of server activities.  

 

Applications include— 

• Control of a server located in a machine room 

• Ingest station for loading commercials and other content from tape 

• Edit station for trimming content 

• Building, editing and running playlists 

• Remote control of a server located at a transmitter site (“evergreen” backup) 

• Access to file content and operations by engineering or management 

• Control of more than one server from a single workstation 

• On a wireless network, a server can be controlled by a secure  
Wi-Fi enabled laptop computer 

• Remote control in a conference room, or during auditorium presentations 

• Servers may be securely controlled from a remote location, even across public Internet 
connections, with inexpensive VPN (Virtual Private Network) technology. 

A single server may be controlled from more than one different location on the network. See  
Figure 40.  

 
Similarly, a single computer can run multiple Remote Workstations to control multiple servers. 

Remote Workstation software provides the same functionality as the local GUI with the 
following exceptions: It cannot access the server’s network configuration screen, shutdown the 
server, access the RAID status display, or display the server’s time-of-day clock. 

 

As of this writing, the current version of Remote Workstation is 3.05.22; this is required to 
work with server software version 1.08.561. 

 

System Requirements 
• PC with Windows XP, Vista or Windows 7 installed.  Other operating systems have not been 

tested and may not be supported.  

• 10 MB free space on the computer hard disk, plus 128 MB RAM. 
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Figure 40 - Remote Workstation Deployments 

About the Remote Workstation Interface 
The Remote Workstation Interface consists of a CD-ROM or USB flash drive carrying the 
Remote Workstation application for Windows XP, Vista or Windows 7 computers.  It self-
installs using the normal Windows prompts. It is possible to install the Remote Workstation 
software on a number of PCs; any of them can then control one or more channels of one or 
more servers. Simultaneous active RWI connections to a particular server should be limited to 
three. 

Operations 
Up to four Remote Workstations can simultaneously view the channel activity of a single 
server.  Only one Remote Workstation at a time can take control of a particular video channel.  
Control of the server video channel is not automatically granted to a Remote Workstation just 
by attempting to use the GUI; control must be actively taken, using the TAKE CONTROL 
option described below.  This allows remote monitoring of server channel activity while greatly 
reducing the likelihood that a remote user will interfere with operations initiated by another.  
All Workstations, including the server’s local GUI, have equal priority and any can take control 
of a video channel at any time.  Control is granted for server channels individually, and not 
automatically for all four; therefore, four Remote Workstations can each control a separate 
video channel.  Each Remote Workstation can display or close transport windows without 
affecting other Workstations or the Local GUI. 

The IP address of a Remote Workstation currently controlling a channel appears in the status 
bar on the bottom-left of the Playlist or Channel window. 

A menu labeled Options appears at the upper-left of each server channel window. Clicking this 
menu presents a drop-down menu with a TAKE CONTROL option.  Select this then click Yes in 
the confirmation dialog to give control of the video channel to your workstation.  
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Installation 
To install Remote Workstation software from CD-ROM or USB drive, insert the media into the PC.   

• The auto-run capability of Windows will start the Remote Workstation setup program.  If it does 
not, select the Run… option of the taskbar Start Menu and type: D:\setup.exe. If necessary, 
replace D:\ with the drive letter of the flash drive. 

• You will be prompted to enter the IP address of the server you wish to control.  If you know the 
address, enter it here.  This information can also be entered after installation. 

• Read the terms under which this software is licensed to you. If you agree, installation will 
continue. If you do not agree, installation will stop. Follow the prompts to finish installation. 

• By default, the Remote Workstation software installs all required files into the  
“C:\Program Files\ Image Server RWI” folder. However, during the installation process an 
alternate directory may be specified. If a previous version of Remote Workstation is already 
installed on the Host computer, use this feature to install the new version in a uniquely named 
folder, for example C:\Program Files\MAXX2420-EX. 

After Installation 
A 360 Systems Remote Workstation icon will appear on your desktop.  Double click the icon 
to open a remote session on the server.   

 

 

 

 

To change the target server you wish to access, right 
click on the Remote Workstation icon.  Select 
“Properties” from the drop-down menu.  In the 
“Target” text box, change the IP address listed in the 
box to the IP address of the server and select “OK”. 

 

 

 

Figure 41 – Remote Workstation Properties Page 
 

Because multiple simultaneous sessions of Remote Workstation may be run on a single PC, it is 
possible to make copies of the Remote Workstation icon and change the IP address of each, to 
permit access to any number of servers. Simply right click on the Remote Workstation icon and 
select Copy from the pop-up menu.  Next, right click anywhere on the desktop and select 
Paste.  Finally, follow the instructions above to edit the IP address to match the second server. 

Hard Disk Management 
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MAXX-2420-EX employs an advanced Serial-ATA controller that manages eight high-capacity 
hard disks operating in a RAID-5 configuration.  This design increases system performance, and by 
storing parity data, can survive the complete loss of a drive in the array without data loss. 

The MAXX-2420-EX brings a high level of reliability to Serial-ATA RAID through a switched 
architecture that exceeds the reliability of SCSI shared-bus storage systems.  The earlier shared-bus 
architecture of SCSI had inherent performance limitations due to arbitration latency, since only one 
drive may use the bus at a time.  Further, a single drive failure could bring the entire storage system 
down. 

By contrast, the MAXX-2420-EX uses a non-blocking switched architecture to isolate the drives 
from one another.  Any drive failure makes that drive unavailable and the rest of the storage system 
remains undisturbed.  In addition, the MAXX-2420-EX uses Advanced Data Protection features, 
where all drive commands are checked to ensure that no command corruption has taken place 
over the entire data path. 

Some of the MAXX-2420-EX’s RAID-5 implementation features and benefits include: 
  

• Non-blocking switch technology with RAID-5 parity 
• On-board processor minimizes host CPU overhead 
• Easy-to-configure arrays  
• Dynamic sector repair for robust data protection 
• Accelerated RAID-5 writes 
• Easy drive replacement from front panel 
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About RAID 5 
A RAID 5 configuration features the data striping of RAID 0, combined with the parity benefits 
of RAID 4.  Using a parity (exclusive OR) function, RAID 5 can tolerate the loss of one drive.  
Parity information is distributed across all drives rather than being concentrated on a single 
disk.  This avoids throughput loss due to contention for the parity drive.  Spare drives can be 
used to rebuild an array after a drive is replaced. 

RAID-5 capacity equals the size of drive times (number of drives -1).  In addition, the array’s 
storage efficiency increases with the number of disks; from 66.7 % for 3 drives to 75 % for four 
drives: storage efficiency = (number of drives -1) X (number of drives). 

P 10 11 12 

RAID Level 5: 
“Independent Access Array with Rotating Parity” 
High Data Reliability & Transfer Capacity 

Disk 2 Disk 1 Disk 0 Disk 3 

4 5 P 6 

1 2 3 P 

7 P 9 8 
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DATA 

Array Management Software 
Provides Logical to Physical Mapping 

Physical 

  

Figure 42: RAID 5 Array Schematic 

Improved Write Performance 
The server uses new designs to improve RAID-5 write performance for both large sequential 
and small random transactions.  This advanced block caching firmware delivers extremely high 
performance for RAID-5 write operations. 
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Managing Disk Arrays 
The MAXX-2420-EX’s Disk Array Configuration Utility provides tools for monitoring and 
managing the disk array.  Monitoring and troubleshooting programs automatically check the 
array, report problems and provide access to RAID status information and service options.  

If up to two drive faults should occur, it should not cause data loss; but remember that the drive 
array is degraded and no longer has fault tolerance.  Hence, another disk failure will cause a 
complete loss of data and system failure.  After a drive failure it is strongly recommended that 
at the earliest time diagnostics be performed. 

Error Notification and Repair 
The server will notify users in the event of a fault by flashing the front panel DRIVES light.  A 
flashing DRIVES light can be triggered by a variety of conditions. A failure condition will also be 
indicated in the Image Server GUI in the status bar, on the bottom of the screen and 
highlighted in yellow ( Figure 43 ).  A GPIO Output can be programmed to activate upon a 
RAID or system fault. This can be used to activate a warning lamp or alarm. Refer to Page 52 
for more information on programming GPIO events. A drive fault can be trigged by a variety of 
conditions.  The first step in response to an error warning is to open the RAID CHECK 
STATUS window from the On-Screen Start Menu.  Click Start > RAID Status to launch the 
RAID Array Configuration Utility.   

 

 

Figure 43 - GUI Drive Fault Indication 
 

The RAID Maintenance window (Figure 47, page 108) displays the current status of the RAID 
controller and all disks connected to the RAID system.  On inspection, you will find the array 
in one of the following states: 

• OK, indicated by "OK" for Array Unit 0 and all Ports (drives); 
• Initializing, indicated by "Initializing" on the Array Unit 0 status line; 
• Degraded, indicated by "Degraded" on the Array Unit 0 status line; 
• Verifying, indicated by "Verifying x%" on the Array Unit 0 status line. 
• Rebuilding, indicated by "Rebuilding x%" on the Array Unit 0 status line. 
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IMPORTANT 

The term “DEGRADED” refers to the state of the Array data, not necessarily the 
hardware or disk drives themselves. It indicates that the parity information that 
protects the data is not up to date.  While it can be caused by hardware problems, it 
can also be the result of something as simple as power loss without a proper 
Shutdown operation. 

  

“Verifying” is the process by which the array controller corrects data parity errors that may have 
occurred because of power loss, incorrect shutdown or some other data error.  Upon detection 
of a parity error, the controller will automatically start the rebuilding process as a background 
task.  This task should not interfere with MAXX-2420-EX’s ability to record or play clips. 

The term “degraded” refers to the state of the Array data, not necessarily the hardware or disk 
drives themselves. It indicates that the parity information that protects the data is not up to date. 

Parity errors may occur if the server loses power, or is improperly shut off.  No data will be 
lost, but the parity re-initialization process may take several hours.  NEVER disconnect AC 
power to shutdown the server.  Shutdown the system only by momentarily pressing the front 
panel RESET button or selecting Start > Shutdown > Shutdown from the graphic user 
interface. 

Note that in some cases the power may not automatically shut off after a Shutdown is executed.  
When the front panel LED indicators start flashing in response to the Shutdown command, the 
file system has been successfully closed and it is safe to force the power off by holding the 
RESET button in for four seconds. 

A Degraded array with a drive listed as “Not In Use”, “Not Present”  or “Inaccessible” is usually 
indicative of a permanent drive error; redundant data will still allow normal operations to 
continue.  You may first try to rebuild the array with the existing drive still installed.  If the array 
continues to indicate a failed drive, replace the drive and then rebuild the array.  The 
replacement must be a drive from the same model series and the same or greater capacity as 
other drives in the array.  Because specific drive models become unavailable as time goes on, 
360 Systems recommends that maintenance spares be purchased at the same time as the server.   
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Log-In to the RAID Utilities  

 

Figure 44 - RAID Utilities Login Screen 
 

To log in to the RAID utilities, perform the following steps.  The screen above will appear. 

• Open the RAID utilities by selecting Start > Raid Status 

• In the Login menu, click the drop down arrow and select ADMINISTRATOR.  

• In the Password window, make no entry; leave it blank.  In the event this does not work, 
use the password “3ware”. 

• Click the Login button to enter the Login Utilities. 
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Determining the Condition of the RAID Array 

 

Figure 45 - RAID Array Condition Screen 

 

To check the condition of the array in the RAID Status utility, perform the following steps.  The 
screen above should appear. 

• Login as ADMINISTRATOR. 

• Note the Status on this Summary Screen. 

• If an error condition is indicated continue to next page.  
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Displaying the Alarm Log of the Raid Array 

 

Figure 46 - RAID Alarm Log Screen 
The RAID controller keeps track of any condition that would adversely affect its reliability.  In 
the event that an error should occur, the alarm log will be helpful in diagnosing the problem.   

• Select Monitor > Alarms from the screen. The screen above will appear. 
• Make note of any error conditions reported, and what Port numbers they refer to. 

Some examples of error messages are: 
Drive Timeout Error – The drive failed to respond to a command from the controller within the 
allotted time.  This is sometimes a benign condition, but often indicates a hardware problem 
with the drive. 

Drive Error – The drive reported a data error.  A rare isolated occurrence may be acceptable, 
but probably indicates a drive failure. 

Drive SMART Threshold Exceeded – The drive’s self diagnostic program is reporting an 
impending drive failure.  The drive should be replaced. 

Remapping Bad Sector – This is a normal function of a hard drive’s self maintenance. As a 
drive ages it is normal for sectors to fail, these are reassigned to a different part of the drive. 
Several may occur within a very short period (seconds to a few minutes.).  Multiple such errors 
within a few days may indicate an impending drive failure. 

Unclean Shutdown Detected – Power was lost without an orderly shutdown sequence, and 
the parity information was not updated.  Normally a Rebuild is all that is required. 
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Checking Status of the Drives  

 

Figure 47 - RAID Array Maintenance Screen 
 

To check the status of the RAID drive array, perform the following steps.  The above screen 
should appear. 

• Select Management>Maintenance. 

• Note the status of each drive in the array. 
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Removing the Degraded Drive from the RAID Unit 

 

Figure 48 - Removing Failed Drive from Array 
 

The Unit Maintenance screen above will appear. 

• Remove the degraded drive from the array unit by clicking [Remove Drive]. 
• Select the Rescan Controller option on the above screen to have the system recognize 

the drive as Available. 
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Rebuilding the RAID Array 

 

Figure 49 - Selecting a drive to rebuild 
 

• Select Rebuild Unit.  The dialog above will appear. 

• Select the available drive by clicking the check box. 

• Press OK.  The RAID array will begin rebuilding with the new drive.  This process may take 
a long time, but the MAXX-2420-EX can still be used.  

• When complete, OK will be shown in the status for all ports on the Maintenance menu.  

Replacing Hard Drives 
The server hard disk drives have been factory tested and configured in a RAID 5 array.  Each drive 
is numbered (0-3) and must be attached to the correctly numbered data cable.  Drive bays are also 
numbered. 

Please read Opening the Front Panel on page 116 for instructions on accessing the hard drive bays.  
Detailed information about how to replace hard drives is on page 118. 
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RAID Controller Settings 
The server RAID controller is configured at the factory.  The following is provided only to verify 
these settings and to recreate them if necessary in the event the system is rebuilt.   

Do not use the Scheduled Events, Email Announcement or Remote Login features. 

These settings are critical to proper operation of the system.  The only parameter that can be 
changed is “Continue on Source Error during Rebuild” which when turned on relaxes the condition 
that any error found in the source material will stop the rebuild process. 

It is particularly critical that the Write Cache be checked. 

 

 

Figure 50 – RAID Controller Settings 
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Multi-Channel Audio 
 

Audio Input/Output Modules 
In addition to embedded audio, provided as a standard feature on the MAXX-2420-EX, an 
analog audio and a digital audio I/O module are available as optional accessories. Each 
provides for a total of eight audio channels on XLR-3 connectors, for each video input or 
output. 

DXP-1 Digital Audio Module 
The DXP-2 Digital Audio Module provides 8 audio channels in AES/EBU format, for each video 
input or output. It is housed in a 2-RU rack-mount enclosure (3½” – 88mm height), which 
connects to the server chassis with a 1-meter, 68-pin cable included with the DXP-1. The DXP-
1 is self-powered from AC mains, and contains all audio circuitry. (It is not a connector ‘break-
out box’.) 

 

 

DXP-1 Digital Audio I/O Module 

 

Audio outputs from the DXP-1 duplicate the embedded digital audio contained in the video. 
They are at a fixed 48 KHz sample rate, and are normally referenced to video genlock. Digital 
audio input signals should also be at 48 kHz, and be derived from video genlock. 

When used in combination with DXP-1, the MAXX-2420-EX can record, store, and play 
compressed or specially-encoded digital audio such as Dolby®-E, AC-3, or DTS®, using 360 
Systems’ Bit-for-Bit® technology. The output data stream remains identical to the input data. 

The DXP-1 contains dual redundant power supplies operated from two separate AC mains 
connections. Either power input can be lost, with no effect on audio throughput. Two blue 
LEDs indicate operation of the power supplies. There are no other controls or adjustments on 
the DXP-1.  
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DXP-1 Technical Specifications 
 

Digital Audio Module  
Audio channels  8 per video channel (3 outputs x 8, 1 input x 8)  
Audio format AES/EBU 
Word Size 24-bit 
Sampling Frequency 48 kHz 
Audio connector XLR-3, gold plated 
Data connection to server 68-pin x 1-meter cable connects DXP-2 to MAXX-2420-EX 
Audio synchronization Derived from video genlock 
Dolby® compatibility  Bit-for-Bit® reproduction of compressed audio data 
Dimensions  3½” x 19” x 5¼“ [90 x 483 x 133mm] HWD.  
Weight 8 lb [3.6 kg] net 
Power 100 – 240 volts, 50/60 Hz, 50 watts 
Power supplies Modular, dual, redundant with separate IEC AC mains connectors 
Cooling Convection 
Operating temperature 40º F to 85º F [4ºC to 29ºC] 
Approvals RoHS compliant 
Country of manufacture U.S.A. 

 

AXP-3 Analog Audio Module 
 
The AXP-3 Analog Audio Module provides 4 channels of balanced, +4 dBu analog audio on 
XLR connectors, for each video input or output. The AXP-4 Analog Audio Module may also be 
used in conjunction with the AXP-3, providing 4 additional audio channels—normally channels 
4 through 8. Audio outputs from the AXP-3 and AXP-4 exactly duplicate embedded audio 
contained within a video stream. 

The AXP modules are housed in a 2-RU rack-mount enclosures (3½” – 88mm high), which 
connect to the main server chassis with a 1-meter, 68-pin cable, included with the AXP. The 
module is self-powered from AC mains, and contains all audio circuitry. (It is not a connector 
‘break-out box’.)  

 

AXP-3 Analog Audio I/O Module 

The AXP modules contain dual redundant power supplies, operating from two separate AC 
mains connections. Either power input can be lost with no effect on audio throughput. Two 
blue LEDs indicate operation of the power supplies.  

Precision internal trimmers allow input-output gain to be adjusted by ±1 dB. There are no 
external controls or adjustments on the AXP modules.  
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AXP3/AXP4 Technical Specifications 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

Analog Audio Module  
Audio channels  4 per video channel 
Word Size 24-bit 
Sampling Frequency 48 kHz 
SNR > 106 dB A-wtd. Ref to FS –1 dB 
THD+N < .01% 
Input impedance Z=10 k-ohm per leg 
Output impedance Z-50 ohm per leg 
Headroom 20 dB above nominal +4 dBu operating level 
Audio connector XLR-3, gold plated 
Data connection 68-pin x 1-meter cable connects AXP to MAXX-2420-EX 
Dimensions  3½” x 19” x 5¼“ [90 x 483 x 133mm] HWD.  
Weight 8 lb [3.6 kg] net 
Power 100 – 240 volts, 50/60 Hz, 50 watts 
Power supplies Modular, dual, redundant with separate IEC AC mains connectors 
Cooling Convection 
Operating temperature 40º F to 85º F [4ºC to 29ºC] 
Approvals RoHS compliant 
Country of manufacture U.S.A. 
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Maintenance 

Fault Diagnostics 

Front Panel Indicators 
The five LED indicators on the front panel are used to diagnose server fault conditions.  The 
meaning of each indicator is noted in the following table.  During normal operation, all five 
LEDs will be on. 
 

GENLOCK OFF indicates that the Genlock 
setting in the System menu is 
“Internal” 
FLASHING indicates that Genlock is 
selected in the System menu, but 
there is no signal, or an invalid signal, 
at the GENLOCK input connector. 

Check the Genlock setting in the On-
Screen System menu. 
Check the Genlock cable connections 
or signal. 

POWER FLASHING indicates that there is a 
fault in the system power supply. 

Shut down the server and contact 360 
Systems Customer Support for further 
hardware diagnosis. 

FANS FLASHING indicates that an internal 
chassis or CPU fan is running slow or 
stopped. 

Check the chassis fan operation.  
Replace if necessary.  Do not run the 
server without a working fan. 

DRIVES FLASHING indicates that there is a 
fault in the system RAID array. 

Check the RAID array status using 
the utility under 
Start >Raid Status. 

SYSTEM FLASHING indicates that the CPU or 
other temperature or voltage reading 
is not within manufacturer’s 
specification. 

Shut down the server and contact 360 
Systems Customer Support for further 
hardware diagnosis. 

 

 

Repairs should be performed only by 
qualified electronics technicians. 
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Gigabit Ethernet Indicators 
 
The Gigabit Network Port card has the following indicator lights: 

 Label Indication Meaning 
Green on The port is connected to a valid link partner 

Green flashing Data activity ACT/LNK 
(Left) 

 Off No link 
Off 10 Mb/sec 

Green 100 Mb/sec 
10=OFF 

100=GREEN 
1000=YELLOW 

(Right) Yellow 1000 Mb/sec 

 

Access To Components 
 

 

Be certain to shut down the server and disconnect the power cord before 
opening the unit for service. 

 
The following sections provide instruction on disassembly and re-assembly for maintenance. 

Opening the Front Panel 
The front panel is easily opened for access to the eight disk drives. Using a coin or a flat-blade 
screwdriver, unscrew the two large panel fasteners on the left and right sides of the front panel. 
Pull outward to remove cover. 

To re-install the front panel, verify that all wires are within the chassis, then place the front 
panel into position and tighten the front panel access screws just enough to be snug. 

Removing the Top Cover  
Use a No. 2 Philips head screwdriver to remove the 13 screws attaching the top cover, and 
then lift it off. 
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General Handling Precautions 
ESD Precautions 

 

Observe electrostatic discharge (ESD) precautions to avoid 
damaging static-sensitive components when handling any 
PC card or disk drive. 

 
• When the case of your server is open and its internal parts are exposed, do not touch any 

internal part without first grounding yourself to the chassis. 

• Always wear a ground strap or work on an ESD-protective mat. 
• DO NOT remove components from protective packaging until you are properly grounded. 

• Handle printed circuit boards by their edges or by the metal bracket. 
• Don’t touch any pin, contact, lead or component on the printed circuit boards. 

• Keep disk drives in their anti-static package until installed in the server. 
 

Mechanical Concerns 

• Be careful when installing I/O cards into your system.  Excessive force can damage the PC 
boards, cables or the motherboard. 

• Be sure each board is aligned with its slot in the mating connector before installing.  Use care 
to not flex any PC boards. 

• Interface cable connectors must be mated carefully. Use care to not bend any of the pins.  The 
connectors provided are keyed to prevent upside-down insertion. 

• Interface cables are fragile and must not be pinched. Ensure that their dress does not restrict 
airflow from fans or heat sinks within the enclosure. 

• Prior to installation, keep disk drives stored in a foam-lined protective carton to protect them 
from physical damage. 

Installing/Removing I/O Cards 
Request separate repair and replacement part documentation from 360 Systems’ Technical 
Service Department. Tel: +1 (818) 991-0360. Any repair, adjustment or service operation must 
be performed by a qualified technician. 
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Program Updates from USB Memory  
Program updates for the MAXX-2420-EX may be issued from time to time.  The server’s 
operating system and application programs can be updated by the user from a USB Flash Drive 
distributed by 360 Systems.  The current software version is determined by looking in the GUI 
Help>About dialog box. 

To install a program update, follow these instructions.  Please read them completely before 
beginning. 

1. Discontinue all record, play, network transfer or system-level operations. 

2. With power applied, insert a 360 Systems USB Flash Drive into a USB a socket. 

3. Press the front panel power switch briefly to shutdown the server. 

4. Wait 5 seconds, then press the front panel power switch again to boot from the USB 
Flash Drive. 

5. The Installer menu provides a choice to Update the server operating system, begin a 
new complete install, or cancel the install. 

• Choose UPDATE if you want to keep the video and audio clip files that exist on 
the server.  Use this selection for all normal software updates. 

• Choose NEW only if you want to partition and reformat the drive array, and 
install the new operating system. 
 

 

IMPORTANT! 
Using the NEW option will destroy all video and audio files on the server.  For normal 
software upgrades, use the UPDATE option instead of NEW. 
 

 
6. The message, “Please wait while server is being installed” will appear with an activity 

indicator.  When installation is complete, the server will automatically reboot from its 
hard disk array, and will display a copyright notice while starting up.  

7. IMPORTANT! Remove the USB Flash Drive. Never leave it plugged into the server.  Do 
not use the Defragment option unless instructed to do so by 360 Systems. 
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Updating Firmware 
 

Firmware is low-level code used by the video hardware; it is not server operating system 
software.  If a software update is to be performed as well, install it first unless instructions that came 
with the software update specifically require loading a particular version of firmware.  This 
procedure must be done from the local GUI; it cannot be done at a Remote Workstation. The 
following operation should only be undertaken by competent computer technician.  
 
To update the firmware: 

1. Power off the MAXX 2420-EX server by selecting Start > Shutdown > Shutdown.  Power 
on again, using the front panel RESET button, accessible through the small hole near the 
LEDs. 

2. Once the server has finished initializing, close the GUI by clicking the ‘close’ button at the 
upper right corner of the main window. 

3. Open a terminal window by holding the Shift and Control keys and pressing the F12 key 
on the keyboard.  Stop the server application by typing: 
killall app  Enter 

4. Insert the flash memory stick that was supplied with the firmware. Wait several seconds for 
the system to recognize the flash drive. 

5. In the terminal window, type: loadflash  Enter 

You will see messages like the following: 
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After each bank is loaded, you should see the message “Verify complete”. 
The procedure will continue, and finally end with the prompt and cursor: 

 

 

If any of the banks indicate an error during the erase, verify, or programming phases, 
IMMEDIATELY repeat the operation “loadflash Enter” without doing any other operation. 

If the procedure still fails, perform the “loadflash Enter” procedure again. Should you still 
encounter a problem, please contact 360 Systems technical support. 
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Replacing a Hard Drive 
Do not remove a hard drive from the server unless the diagnostic software identifies a 
permanent fault.  In that event, the front panel DRIVES LED will blink.  Use the hard disk 
management tools to verify that a drive is at fault.  The application monitors many things about 
the array and individual drives, and will clearly indicate whether a drive has failed. 
 

CAUTION: 
Do not install drives that are not approved by 360 Systems.  All drives in the RAID array must 
be of a similar model family and the same or greater capacity. 

 

Each hard drive slot is numbered 0 through 3, as are the drives.  If for any reason one or more 
drives have been removed, they must be reinstalled in the same location, the drive number 
matching the numbered location. Installation in the wrong location may destroy data stored on 
all the drives. 

 
If you have ANY doubt that you are replacing the correct drive, try to restart the server with 
the drive disconnected.  It should boot up normally.  Immediately perform the Shutdown 
(Start>Shutdown>Shutdown)  procedure and continue.  If the server does not start normally, 
reconnect the drive and verify which drive is faulty. 

1. Shutdown the server using the front panel RESET button.  After it has shut down, turn off 
the rear AC power switch.  On power supply models without a switch, unplug AC power 
cables. 

2. Remove the front panel as described above. 
3. Unplug the power connector data connector from the drive.  

4. Pull the black tab to slide the drive carrier and drive out.  Remove the drive carrier plate 
and install it on the new drive.  

5. To install a new drive, remove the drive carrier from the old drive and install on the new 
one.  Slide the drive and drive carrier plate into the correct position in the drive shelf. 
Reattach the power and data cables.  

6. Replace the front panel and tighten the two thumb screws until they are just snug. 
7. Turn on the rear panel AC switch or plug AC power cables back in. 

8. Turn the system ON using the front panel RESET button, and check the RAID array status. 
9. Verify correct operation of the server. 
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Factory Repair Policy  
A video server being returned under warranty shall be sent to 360 Systems, freight prepaid, in 
the original or equivalent packaging.  Call 360 Systems for a return authorization number 
before returning a product.  Have your serial number and software version number available 
for reference. 

Use the following address for shipping and correspondence.  360 Systems’ offices are open 
Monday through Friday, from 8:30 AM to 5:00 PM, Pacific Time. 

 
360 Systems  Telephone (818) 991-0360 
Customer Service Dept. Fax (818) 991-1360 
3281 Grande Vista Drive E-mail info@360systems.com 
Newbury Park, CA  91320 Website www.360systems.com 

Regulatory Certifications 

Safety  
The server complies with the following safety standards: 

UL60065, Issue:2003/06/30 Ed:7 Rev2007/12/11, Standard for Safety for Audio, Video and 
Similar Electronic Apparatus – Safety Requirements 

CSA C22.2#60065, Issued:2003/04/01 Ed:1, Audio, Video and Similar Electronic Apparatus – 
Safety Requirements – IEC 60065:2001; Supercedes E60065-00-CAN/CSA; Amendment 1: 
April 2006 – (R2007) 

Radio Interference Compliance 
Radio Interference (USA) 

WARNING: This equipment has been tested and found to comply with the limits for Class A 
digital device pursuant to Part 15 of the FCC Rules. These limits are designed to provide 
reasonable protection against harmful interference when the equipment is operated in a 
commercial environment.  This equipment generates, uses, and can radiate radio frequency 
energy and, if not installed and used in accordance with the instruction's manual, may cause 
interference to radio communications.  Operation of this equipment in a residential area is 
likely to cause interference in which case the user will be required to correct the interference at 
his own expense. 

The user is cautioned that changes and modifications made to the equipment without approval 
of the manufacturer could void the user's authority to operate this equipment. 

It is suggested that the user use only shielded and grounded cables to ensure compliance with 
FCC Rules. 



  

MAXX-2420-EX Owner’s Manual Page 123 

FCC Emission Limits 
This device complies with Part 15 of the FCC Rules.  Operation is subject to the following two 
conditions: (1) This device may not cause harmful interference, and (2) this device must accept 
any interference received, including interference that may cause undesirable operation. 

Radio Interference (Canada) 
English: This Class A digital apparatus meets all requirements of the Canadian Interference-
Causing Equipment Regulations. 

Français: Cet appariel numérique de la classe A respecte toute les exigences du Reglement sur 
le matériel brouilleur du Canada 

RoHS Compliance 
This product is in compliance with the Hazardous Substances in Electrical and Electronic 
Equipment directive (RoHS) - 2002/95/EC. The materials and substances listed in the RoHS 
directive, specifically lead, mercury, cadmium, hexavalent chromium, PBB and PBDE's, are not 
intentionally added to, or believed to be contained in this product.  

CE Mark 
Testing to be completed before shipment to the EU.
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Product Warranty 
 

Limited Warranty  

This product is warranted to the original purchaser against defects in material and workmanship for a period of one 
year from the date of original purchase.  This warranty covers parts and labor and is effective when the product is 
used without alteration for the purpose intended by 360 Systems.  This warranty excludes products with modified or 
unauthorized software, that have been subject to misuse or neglect, that have been modified, repaired improperly or 
by unauthorized personnel, damaged by rough handling, abuse, improper operation, excessive temperature, 
lightning strike, static electricity, electrical surges or other electrical system malfunctions, improper or inadequate 
maintenance or care and that have been subject to use of unauthorized or non-conforming accessories or 
attachments.  This warranty also excludes normal wear and deterioration occasioned by the use of the product. 

If part of the product is defective, the entire product must be returned along with the original purchase receipt or 
other evidence of purchase and a description of the defect to 360 Systems, 3281 Grande Vista Drive, Newbury 
Park, CA  91320.  Upon receipt, its condition will be verified, and if the product qualifies for warranty coverage, 
360 Systems will, at its option, repair or replace the product without charge.  In the case of replacement, if the 
replacement for a defective product is no longer available, 360 Systems will replace it with a similar product or, if 
not available, a product of equal value. 

DISCLAIMER AND LIMITATION OF LIABILITY 
The liability of 360 Systems under the foregoing warranty is limited solely to the repair or replacement of defective 
material or workmanship and does not include any expense related to the shipment of the product to or from 360 
Systems or compensation for any inconvenience or loss of use of the product while it is being repaired or replaced. 

EXCEPT AS EXPRESSLY STATED HEREIN, 360 SYSTEMS EXPRESSLY DISCLAIMS ALL WARRANTIES, EXPRESS 
OR IMPLIED, OF ANY KIND WITH RESPECT TO THE PRODUCT, INCLUDING WITHOUT LIMITATION 
WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE.   

BY PURCHASE OR USE OF THIS PRODUCT, THE OWNER/OPERATOR ASSUMES SOLE RESPONSIBILITY 
FOR OBTAINING LICENSES and/or PATENTS ASSOCIATED WITH ITS OWNERSHIP, BROADCASTING, 
RENTAL, OR ANY OTHER USE OF SAID PRODUCT.  THE OWNER/OPERATOR IS SOLELY LIABLE FOR ANY 
BREACH OF THAT RESPONSIBILITY AND SHALL INDEMNIFY AND HOLD 360 SYSTEMS HARMLESS 
FROM ANY AND ALL CLAIMS THAT MAY ARISE IN REGARD TO ANY SUCH LICENSES and/or PATENTS, 
INCLUDING THIRD PARTY PATENT CLAIMS. THIS PROVISION SHALL TAKE PRECEDENCE OVER ANY 
PROVISIONS TO THE CONTRARY IN OWNER/OPERATOR’S PURCHASE ORDERS OR OTHER 
DOCUMENTS.  

360 SYSTEMS’ SOLE LIABILITY UNDER THIS LIMITED WARRANTY SHALL BE THE REPAIR OR 
REPLACEMENT OF ANY DEFECTIVE PRODUCT OR ITS COMPONENTS DURING THE WARRANTY 
PERIOD.  IN NO EVENT SHALL 360 SYSTEMS, ITS DIRECTORS, OFFICERS, EMPLOYEES OR 
REPRESENTATIVES BE LIABLE FOR DIRECT, CONSEQUENTIAL, PUNITIVE, SPECIAL OR INDIRECT 
DAMAGES, LOSS OF PROFITS, INCONVENIENCE OR ANY OTHER LOSSES DUE TO THE PRODUCT OR ITS 
OPERATION, OR ITS FAILURE TO OPERATE IN ACCORDANCE WITH ITS SPECIFICATIONS. 

Some states or regions do not allow the exclusion or limitation of incidental or consequential damages under certain 
circumstances, so the above limitations and exclusions may not apply to you.  This warranty gives you specific legal 
rights, and you may also have other rights which vary from state to state or region to region. 
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End User License Agreement 
For Server Software 
 
IMPORTANT 
THIS IS A LEGAL AGREEMENT BETWEEN YOU (“YOU”) AND 360 SYSTEMS® (“COMPANY”).  
COMPANY IS WILLING TO LICENSE THE SERVER SOFTWARE TO YOU ONLY UPON THE 
CONDITION THAT YOU ACCEPT ALL OF THE TERMS CONTAINED IN THIS SOFTWARE 
LICENSE AGREEMENT (“AGREEMENT”).  PLEASE READ THE TERMS CAREFULLY BEFORE 
OPENING THIS PACKAGE, OR IF DOWNLOADED, BEFORE INSTALLING THE SOFTWARE, AS 
OPENING THE PACKAGE, OR IN THE CASE OF DOWNLOADED SOFTWARE, INSTALLING IT, 
WILL INDICATE YOUR ASSENT TO THEM.  IF YOU DO NOT AGREE TO THE LICENSE TERMS, 
THEN COMPANY IS UNWILLING TO LICENSE THE SOFTWARE TO YOU, IN WHICH EVENT 
YOU MAY RETURN THE UNOPENED SOFTWARE PACKAGE TO THE PLACE FROM WHICH IT 
WAS ACQUIRED WITHIN 14 DAYS OF THE DATE OF PURCHASE AND YOUR MONEY WILL 
BE REFUNDED.  IF YOU ARE VIEWING THIS AGREEMENT ELECTRONICALLY, SELECT THE 
“ACCEPT” BUTTON AT THE BOTTOM OF THIS PAGE TO INDICATE YOUR ACCEPTANCE OF 
THE TERMS OF THIS AGREEMENT.  IF YOU ARE NOT WILLING TO BE BOUND BY ITS TERMS, 
SELECT THE “DECLINE” BUTTON AT THE BOTTOM OF THIS PAGE AND THE REGISTRATION 
OR INSTALLATION PROCESS WILL NOT CONTINUE. 
 
1. Company grants to You a non-exclusive license to use the server software program (the “Software”) and 

any accompanying documentation (“Documentation”) solely for your internal business needs pursuant 
the terms and conditions of this Agreement.  The license to use the Software is conditioned upon Your 
compliance with the terms of this Agreement.  You shall be solely responsible for installation of the 
Software. 
 

2. Your use of the Software is limited to the licensing option set forth on your invoice.  Each licensing 
option is defined as follows: 
Single User License.  Software provided to You under this option may only be installed on any server 
owned or controlled by You, but in no event may it be used on more than one server at the same time. 
Multiple User License.  Software provided under this option may be installed on more than one server 
owned or controlled by You, the maximum number of which is indicated on the purchase invoice for 
this Software. 

3. You may not transfer the Software to another entity or person.  Any such transfer terminates your license 
under this Agreement.  You shall not modify, translate, reverse assemble or reverse compile in whole or 
in part the Software that is provided in object code.  You may not rent, sell, time-share, lease, sublicense, 
transfer, publish, disclose, display, or otherwise make available the object code or copies thereof to 
others.  You may not make copies of the object code except as provided herein.  You shall not tamper 
with, bypass or alter any security features of the Software or attempt to do so. 

4. This license is not a sale.  Title, ownership rights, and intellectual property rights in and to the Software 
and Documentation shall remain with the Company.  You agree to abide by the copyright laws and all 
other applicable laws of the United States, your country, and international law.  You acknowledge that 
the Software design remains a confidential trade secret of Company.  Failure to comply with the above 
restrictions will result in automatic termination of this license and will make available to Company other 
legal remedies.  You may not disclose any of Company’s proprietary or trade secret information relating 
to the Software to any third party. 
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5. Company warrants that the Software will perform substantially in accordance with its Documentation.  
Your exclusive remedy for breach of this limited warranty and Company’s entire liability shall be, in 
Company’s discretion, either return of the price paid to Company by You for the Software, or repair or 
replacement of the Software after Software and Documentation are returned to Company with an 
applicable receipt.  Company’s warranty is void if failure of the Software has resulted from accident, 
abuse, modification or misapplication.  COMPANY MAKES NO OTHER WARRANTIES, EXPRESS OR 
IMPLIED, WITH RESPECT TO THE SOFTWARE AND DOCUMENTATION, AND SPECIFICALLY 
DISCLAIMS THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR 
PURPOSE.  COMPANY DOES NOT WARRANT THAT THE OPERATION OF THE SOFTWARE WILL BE 
UNINTERRUPTED OR ERROR FREE. 
 

6. TO THE MAXIMUM EXTENT PERMITTED BY LAW, IN NO EVENT SHALL COMPANY BE LIABLE FOR 
ANY SPECIAL, INCIDENTAL, CONSEQUENTIAL OR PUNITIVE DAMAGES WHATSOEVER, 
INCLUDING ANY CLAIMS FOR LOST PROFITS, BUSINESS INTERRUPTION, LOST INFORMATION 
OR OTHER DAMAGES ARISING OUT OF THE USE OR INABILITY TO USE THE SOFTWARE.  IN ALL 
EVENTS, COMPANY’S SOLE OBLIGATION OR LIABILITY UNDER THIS LICENSE IS THE 
REPLACEMENT OR REPAIR OF THE SOFTWARE OR A REFUND OF THE PURCHASE PRICE. 
 

7. You may terminate the license granted in Section 1 of this Agreement at any time by destroying or 
erasing your copy of the Software.  Company may terminate this Agreement immediately and without 
notice if you fail to comply with any term or condition of this Agreement.  In the event of termination of 
this Agreement, all the sections of this Agreement will survive except for Section 1. 
 

8. This Agreement shall be governed by and construed in accordance with the laws of the State of 
California, U.S.A., without reference to conflicts of laws provisions or the 1980 U. N. Convention on 
Contracts for the International Sale of Goods and, as to matters affecting copyrights, trademarks and 
patents, by U.S. federal law.  Any dispute with respect to this Agreement shall be brought and heard 
either in the California state courts located in Los Angeles County, California, or the federal district court 
for the Central District, Western Division, located in Los Angeles, California.  In such event, the parties 
to this Agreement each consent to the in personam jurisdiction and venue of such courts.  The parties 
agree that service of process upon them in any such action may be made if delivered in person, by 
courier service, by telegram, by facsimile or by first class mail, and shall be deemed effectively given 
upon receipt. 
 

9. This Agreement sets forth the entire agreement between You and Company pertaining to the licensing of 
the Software, and supersedes in its entirety any and all written or oral agreements previously existing 
between the parties with respect to such subject matter.  If any provision of this Agreement is held 
invalid or unenforceable, such provision shall be revised to the extent necessary to cure the invalidity or 
unenforceability, and the remainder of this Agreement shall continue in full force and effect.  In the 
event of any conflict between any provision of this Agreement and applicable law, the provisions of this 
Agreement affected shall be modified to remove such conflict and permit compliance with such law, and 
as so modified this Agreement shall continue in full force and effect.  This Agreement may not be 
assigned without the consent of Company. 
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Appendix A 

Connector Specifications 
 

Audio XLR-3 Connector Pinout 
Signals appearing on XLR connectors of the DXP-1, AXP-3 or AXP-4 multi-channel audio modules 
conform to the following wiring standard. 

 

Pin BALANCED ANALOG AES/EBU DIGITAL 
1 SHIELD (FRAME GROUND) SHIELD (FRAME GROUND) 
2 " + " OR HOT DIGITAL + 
3 " – " OR COMMON DIGITAL - 

SHELL FRAME GROUND FRAME GROUND 
  

Serial Control Connector Pinout 
 

Pin DB9-F Connector 
1 GND 
2 Transmit A (TX–) 
3 Receive B (RX+) 
4 GND 
5 N/C 
6 GND 
7 Transmit B (TX+) 
8 Receive A (RX-) 
9 GND 

Shell Frame ground 
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BNC Connectors 
The following note applies to all video and Genlock connectors: 

• A BNC connector used as an output has a 75-ohm source impedance. 
• A BNC connector used as an input has a 75-ohm termination. 

 

GPIO Connectors 
General purpose control inputs (GPI) may be applied to the GPIO connectors, which are  

DB-25 pin connectors.  These inputs are optically isolated from the server circuitry; individual 
floating returns are provided.  +5 volts may be sourced from pins 18 or 26, or provided from an 
external source.  Current limiting devices are provided within the server. 

General purpose status outputs also appear on the GPIO connectors.  Open-collector outputs 
are provided as status outputs, and may be used to drive an external LED or control input. 

Refer to the connector pin-out table and partial schematic, following. Inputs and outputs 1-6 
are on connector 1, 7-12 are on connector 2, shown in parentheses.  The schematic applies to both 
connectors as well. 

GPIO Connector Pinout 

Numbers in parentheses indicate numbering of signals on GPIO Connector 2 

 
Pin Signal Pin Signal 

1 GPI 1 (7) 14 GPI 1 (7) RTN 
2 GPI 2 (8) 15 GPI 2 (8) RTN 
3 GPI 3 (9) 16 GPI 3 (9) RTN 
4 GPI 4 (10) 17 GPI 4 (10) RTN 
5 GPI 5 (11) 18 GPI 5 (11) RTN 
6 GPI 6 (12) 19 GPI 6 (12) RTN 
7 N/C 20 N/C 

8, 9, 10 GND 21, 22 +5V SOURCE (200MA MAX) 
11 GPO 2 (8) 23 GPO 1 (7) 
12 GPO 4 (10) 24 GPO 3 (9) 
13 GPO 6 (12) 25 GPO 5 (11) 

 

 
Warning: Incorrect wiring of GPIO connector may damage its interface circuitry. 
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Figure 31: GPIO Connection Schematic 
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System Board Ports 
Standard computer I/O ports on the server include video monitor, keyboard, mouse, and 

Gigabit Ethernet. Pinouts are provided to assist in wiring or trouble-shooting. 

Keyboard and Mouse 
Keyboard and mouse ports are provided on the rear panel.  Both ports are provided with a 

resetable fuse protecting the +5V supply to the peripheral. 

SVGA Ports  
An SVGA computer monitor may be connected to the 15-pin video port.  The server is pre-

configured to an SVGA screen resolution of 1024 x 768 and 64,000 colors.  The refresh rate will 
auto-negotiate with the attached monitor to achieve the best available value.  This resolution is best 
viewed on 17-inch or larger monitors.  Use only VESA compliant monitors.  360 Systems does not 
provide a monitor with the server. 

SVGA Connector Pinout 

 

Pin Signal Pin Signal 
1 RED 9 +5V 
2 GREEN 10 GND 
3 BLUE 11 RESERVED* 
4 RESERVED* 12 SDA 
5 GND 13 HSYNC 
6 RED RTN 14 VSYNC 
7 GREEN RTN 15 SCL 
8 BLUE RTN SHELL FRAME GROUND 

  * Pulled high to +5V. 

Unused Ports  
USB ports and an RS-232 serial port are present on the server.  These are not active and no 

connection should be made to them. (USB ports may be used for software/firmware update devices 
only. There are no provisions for USB keyboard, mouse or mass storage devices, and their use may 
cause the server to operate improperly.) 
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Appendix B 
Serial Command Protocols 
 

VDCP Command Table 
The server responds to the following VDCP commands.  Shaded areas indicate commands slated 
for future implementation. 
 

COMMAND FROM CONTROLLER RETURN FROM CONTROLLED DISK 

CMD-1 CMD-2 NAME CMD-1 CMD-2 NAME 
0X / 8X 15 Delete Protect ID  04 ACK 
0X / 8X 16 Undelete Protect ID  04 ACK 

 

CMD-1 CMD-2 NAME CMD-1 CMD-2 NAME 
1X 00 Stop  04 ACK 
1X 01 Play  04 ACK 
1X 02 Record  04 ACK 

1X 04 Still  04 ACK 
1X 05 Step  04 ACK 
1X 06 Continue  04 ACK 
1X 07 Jog  04 ACK 
1X 08 Varispeed Play  04 ACK 
1X 0A EE Mode  04 ACK 

 

CMD-1 CMD-2 NAME CMD-1 CMD-2 NAME 
2X / AX 1D Rename ID  04 ACK 

2X 1E Preset Std. Time  04 ACK 
2X / AX 1F New Copy  04 ACK 

2X  20 Sort Mode  04 ACK 
2X  21 Close Port  04 ACK 
2X  22 Select Port  04 ACK 

2X / AX 23 Record Initialize  04 ACK 
2X / AX 24 Play Cue  04 ACK 
2X / AX 25 Cue with Data  04 ACK 
2X / AX 26 Delete ID  04 ACK 
2X / AX 2C Record Init with Data  04 ACK 

2X  30 Preset  04 ACK 
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CMD-1 CMD-2 NAME CMD-1 CMD-2 NAME 
3X  01 Open Port 3X 81 Grant/Denied 

3X / BX 02 Next 3X 82 List of ID's 
3X  05 Port Status Request 3X 85 State Status 
3X  06 Position Request 3X 86 Position 

3X / BX 07 Active ID Request 3X 87 Active ID 
3X  08 Device Type Req. 3X 88 Device Type 
3X  10 Syst. Status Request 3X 90 System Status 

3X / BX 11 ID List 3X 91 List of ID's 
3X / BX 14 ID Size Request 3X 94 ID Size 
3X / BX 16 ID Request 3X 96 ID Presence 

3X  17 Compression Settings 
Request 

3X 97 Compression Settings

3X / BX 18 ID's Added List 3X 98 List ID's Added 
3X / BX 19 ID's Deleted List 3X 99 List ID's Deleted 

 
AX and BX versions are long-filename variants. 
Macro commands (5X/DX in CMD-1) are not implemented. 
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P2 (BVW) Serial Command Table  
The server command set includes most BVW-type commands. Commands not implemented 

include those for DMC operations, audio split and in/out points, and those specifically related to 
tape as a medium. 

COMMAND DESCRIPTION RETURN COMMENT 
00.11 DEVICE TYPE REQUEST ACK  
00.1D LOCAL ENABLE ACK  
00.0C LOCAL DISABLE ACK  
20.00 STOP ACK  
20.01 PLAY  ACK  
20.02 RECORD ACK  
20.10 FAST FORWARD ACK  
2X.11 JOG FORWARD ACK  
2X.12 VAR FORWARD ACK  
2X.13 SHUTTLE FORWARD ACK  
20.20 REWIND ACK  
2X.21 JOG REVERSE ACK  
2X.22 VAR REVERSE  ACK  
2X.23 SHUTTLE REVERSE ACK  
20.30 PRE-ROLL ACK  
20.0F EJECT ACK  
20.05 STANDBY ON ACK  
20.60 FULL E-E OFF ACK   
20.61 FULL E-E ON ACK  
24.31 CUE UP WITH DATA ACK  
40.08 TIMER 1 RESET ACK  
40.10 IN ENTRY ACK  
40.11 OUT ENTRY ACK  
40.18 IN SHIFT + ACK  
40.19 IN SHIFT - ACK  
40.1A OUT SHIFT + ACK  
40.1B OUT SHIFT - ACK  
40.2D LOST LOCK RESET ACK   
41.36 TIMER MODE SELECT ACK  
41.37 INPUT CHECK ACK  
44.00 TIMER 1 PRESET ACK  
44.04 TIME CODE PRESET ACK  
44.31 PRE-ROLL TIME PRESET ACK   
41.33 SERVO REFERENCE SELECT ACK   
N/A TIMER MODE STATUS ACK  

7X.20 STATUS DATA 7X.20  
N/A COMMAND SPEED SENSE 71.2E  

40.48 REF VIDEO SELECT ON ACK   
40.49 REF VIDEO SELECT OFF ACK   
6X.0E CURRENT TIME SENSE  ACK  

ACK= 10.01  NAK=11.12.xx 
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Odetics® Protocol 
Odetics serial protocol is an extension of P2 machine control protocol.  Among its most 
significant features is the selection of a file by name rather than by time-code location, as with 
P2.  Odetics protocol is used by many table-top controllers and some automation systems.   

Note that the Odetics protocol only supports clip names up to 8 characters.  Longer clip 
names are automatically filtered out from responses by the server. 

ACK = 0X1001 

COMMAND DESCRIPTION RETURN COMMENT 
0X1001 ACK   
0X000C   LOCAL DISABLE  ACK  
0X0011   DEVICE TYPE 0X1211 BVW-75 
0X001D   LOCAL ENABLE ACK  
0X2000   STOP ACK  
0X2001   PLAY ACK  
0X2002   RECORD ACK  
0X2004   STAND BY OFF ACK  
0X2005   STAND BY ON ACK  
0X200D   DMC START ACK COMMAND HAS NO EFFECT

0X200F   EJECT ACK  
0X2010   FAST FORWARD ACK  
0X2X11   JOG FORWARD ACK  
0X2X12   VAR FORWARD ACK  
0X2X13   SHUTTLE FORWARD ACK  
0X2020   REWIND ACK  
0X2X21   JOG REVERSE ACK  
0X2X22   VAR REVERSE ACK  
0X2X23   SHUTTLE REVERSE ACK  
0X2030   PREROLL ACK  
0X2X31   CUE UP ACK  
0X2X38   PROG SPEED PLAY PLUS ACK  
0X2X39   PROG SPEED PLAY MINUS ACK  
0X2052 TENSION RELEASE ACK COMMAND HAS NO EFFECT

0X2054   ANTI CLOG TIMER DISABLE ACK COMMAND HAS NO EFFECT

0X2055   ANTI CLOG TIMER ENABLE ACK COMMAND HAS NO EFFECT

0X2X5C   DMC SET FORWARD ACK COMMAND HAS NO EFFECT

0X2X5D   DMC SET REVERSE ACK COMMAND HAS NO EFFECT

0X2060   FULL EE OFF ACK  
0X2061   FULL EE ON ACK  
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COMMAND DESCRIPTION RETURN COMMENT 
0X4X00   TIMER1 PRESET ACK  
0X4X04   TIME CODE PRESET ACK  
0X4008   TIMER1 RESET ACK  
0X4010   IN ENTRY ACK  
0X4011   OUT ENTRY ACK  
0X4X14   IN PRESET ACK  
0X4X15   OUT PRESET ACK  
0X4018   IN SHIFT PLUS ACK  
0X4019   IN SHIFT MINUS ACK  
0X401A   OUT SHIFT PLUS ACK  
0X401B   OUT SHIFT MINUS ACK  
0X4020   IN RESET ACK  
0X4021   OUT RESET ACK  
0X402D   LOST LOCK RESET ACK  
0X4X30   EDIT PRESET ACK COMMAND HAS NO EFFECT

0X4X31   PRE-ROLL TIME PRESET ACK  
0X4X32   TAPE AUTO SELECT ACK  
0X4X33   SERVO REFERENCE SELECT ACK  
0X4X34   HEAD SELECT ACK COMMAND HAS NO EFFECT

0X4X35   COLOR FRAME SELECT ACK COMMAND HAS NO EFFECT

0X4X36   TIMER MODE SELECT ACK  
0X4X37   INPUT CHECK ACK  
0X4040   AUTO MODE OFF ACK  
0X4041   AUTO  MODE ON ACK  
0X4046   VARIABLE MEMORY OFF ACK  
0X4047   VARIABLE MEMORY ON ACK  
0X4048   VIDEO REFERENCE DISABLE OFF ACK COMMAND HAS NO EFFECT

0X4049   VIDEO REFERENCE DISABLE ON ACK COMMAND HAS NO EFFECT

0X4X70   VIDEO INPUT SELECT ACK  
0X4X91   OUTPUT VIDEO LEVEL ACK COMMAND HAS NO EFFECT 

0X4X92   OUTPUT SETUP BLACK LEVEL ACK COMMAND HAS NO EFFECT

0X4X93   OUTPUT CHROMA LEVEL ACK COMMAND HAS NO EFFECT

0X4X98   OUTPUT H PHASE ACK COMMAND HAS NO EFFECT

0X4X99   OUTPUT SC PHASE ACK COMMAND HAS NO EFFECT

0X4X9A   OUTPUT VIDEO HUE  ACK COMMAND HAS NO EFFECT

0X6X0A   TC GEN DATA SENSE   
                    GEN TIME DATA 0X7408  
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COMMAND DESCRIPTION RETURN COMMENT 
      GEN UB DATA 0X7409  
      GEN U BAND TC DATA 0X7809  

0X600C   CURRENT TIME SENSE   
      CORRECTED LTC TIME DATA 0X7414  
      VITC TIME DATA 0X7406  
      TIMER1 DATA 0X7400  
      HOLD USER BITS LTC DATA 0X7415  
      HOLD USER BITS VITC DATA 0X7416  

0X6010   IN DATA 0X7410  
0X6011   OUT DATA 0X7411  
0X6012   A IN DATA NAK  
0X6013   A OUT DATA NAK  
0X6020   STATUS DATA 0X7420  
0X6X23   SIGNAL CONTROL DATA 0X7423  
0X602E   COMMAND SPEED DATA 0X712E  
0X602F   VAR MEM SPEED DATA 0X712F  
0X6X30  EDIT PRESET DATA NAK  
0X6031   PREROLL TIME DATA 0X7431  
0x6036   TIMER MODE STATUS 0X7136  
0XA001  AUTO SKIP ACK ODETICS COMMAND 
0XAX02   CUE UP TO RECORD ACK ODETICS COMMAND 
0XAX04   PREVIEW IN PRESET ACK ODETICS COMMAND 
0XAX05   PREVIEW OUT PRESET ACK ODETICS COMMAND 
0XA006   PREVIEW IN RESET ACK ODETICS COMMAND 
0XA007   PREVIEW OUT RESET ACK ODETICS COMMAND 
0XAX10   ERASE ID ACK ODETICS COMMAND 
0XA014  LIST FIRST ID 0X8814 ODETICS COMMAND 
0XA015   LIST NEXT ID 0X8814 ODETICS COMMAND 
0XAX18   ID STATUS REQUEST 0X8818 ODETICS COMMAND 
0XA01C   MAXIMUM STORAGE LENGTH 0X891C ODETICS COMMAND 
0XAX20   SET DEVICE ID ACK ODETICS COMMAND 
0XA021   DEVICE ID REQUEST 0X8821 ODETICS COMMAND 
0XCX01     JUMP FORWARD X FRAMES ACK ODETICS COMMAND 
0XCX02     JUMP BACK X FRAMES ACK ODETICS COMMAND 
0XCX03     GET LOADED ID ACK ODETICS COMMAND 
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Appendix C 
Technical Specifications 

 

 

Video 
Video Input  2 Channel 
Video Outputs 4 Channels (2 are bidirectional) 
HD Input/Output  HD-SDI, SMPTE 292M 
Monitoring Outputs Letterboxed composite video (optional) 
HD Video Formats 1080i or 720p at 59.94 or 50 fps 
Video Encoding  JPEG-2000 to 125 Mb/Sec 
Jog/Shuttle Zero to 255X, forward/reverse 
Slow Motion Play with audio Zero to 2X,  forward/reverse 
Channel Ganging 2, 3 or 4 -channel synchronized playback for key & fill or multi-screen display 
Audio  

Embedded Audio  8 channels – SMPTE 299M (per video channel) 
DXP-1 Multi-channel 
AES/EBU Module 

Optional accessory. 8 AES/EBU digital audio channels per video input or 
output. (4 AES/EBU pairs) XLR-3 connectors 

AXP-3 Multi-channel Analog 
Audio Module 

Optional accessory. 4 analog audio channels (#1 thru 4) per video input or 
output. Balanced, +4 dBu, XLR-3 connectors 

AXP-4 Multi-channel Analog 
Audio Module 

Optional accessory. 4 analog audio channels (#5 thru 8) per video input or 
output. Balanced, +4 dBu, XLR-3 connectors. For use with AXP-3 module. 

DXP-1, AXP-X dimensions 3½” x 19” x 5¼“ [90 x 483 x 133mm] HWD. Weight: 8 lb [3.6 kg] 
Program Storage 
Disk Storage System 16 Terabyte Serial ATA array, 8 drives, RAID-5 
Storage time 330 hours approx. @ 80 Mb/sec 
Drive Replacement Front panel access 
Software upgrades USB drive 
Network Connectivity 
File import/export JPEG-2000 files via FTP 
Remote GUI PC w/ Remote Workstation software 
As-Run Logs Ethernet transfer 
Diagnostics Download of sequential events 
Miscellaneous 
Serial Control VDCP, BVW, Odetics; 9-pin D 
GPI 12 opto-isolated inputs, 12 open-collector outputs, 2 x 25-pin D 
VBI & Ancillary Data User selectable VANC. Any 6 lines within lines 8-22 (cc, AFD, etc) 
Genlock Input SMPTE 170M; PAL: ITU-R BT.470 (blackburst) 
Fault Monitoring LEDs Front Panel LEDs: power, genlock, fans, system, RAID status 
Fault Monitoring Output Fault outputs on GPO 
Operating System Linux® 
Power & Mechanical 
Power Supply 100-240 V, 50/60 Hz, 200 W modular power supply 

100-240 V, 50/60 Hz, 460 W. Dual, modular, redundant (optional) 
Mechanical Rack mounting: 3.47” x 19” x 23.41” (88 x 483 x 595 mm) HWD. 
Cooling Multiple fans 
Weight Approx 50 lbs (23 Kg) net 
Agency Approvals ETL Intertek, FCC Class A, RoHS 
Country of Origin Made in U.S.A. 
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Keyboard Shortcuts 

Transport Control  Edit Operations 

L Forward at 4x, 16x, 64x, 128x  E Enter/Exit Edit Mode 

K Pause (Stop)  I Capture Mark In 

J Reverse at 4x, 16x, 64x, 128x  O Capture Mark Out 

Space Bar Play/Pause (toggle)  Shift+R Review Edit 

R Record  Shift+T Review Tail 

Home GoTo Head point   

End GoTo Tail point  Playlist 

Shift+E E/E Toggle  Home Recue 
Shift+L Loop Toggle  Space Play/Pause 
Shift+C Local Toggle  K Stop 
Shift+J Eject Clip   

Right Arrow Jog forward 1 frame  Playlist Edit 

Left Arrow Jog reverse 1 frame  Shift+C Clear 
   Left Arrow  << (Remove clip) 
File Operations  Right Arrow >> (Add clip) 
Ctrl+N New   

Ctrl+O Open  Navigating Between Channels 

Ctrl+S Save  Ctrl+<number> 
Switches to Transport 
Channel <number> 

Ctrl+A Save As  Alt+<number> 
Switches to Playlist  
Channel <number> 

Ctrl+D Delete   

Ctrl+R Rename  Mark In/Mark Out Times (Edit Mode) 

  <number> Inserts right justified number
Menu Operations  DEL Removes last digit 
Alt+F Expands File Menu  ESC Aborts time code entry 
Alt+T Expands Transport Menu  .  ;  :  (any) Shifts time code left 

Alt+C Expands Configure Menu  TAB 
Toggles between Mark In  
and Mark Out times 

Alt+P Expands Playlist Menu    

Alt+W Expands Window Menu    

Alt+H Expands Help menu    
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Appendix D 

 Playlist Management Detail  
Playlists can be accessed via the server’s FTP feature, allowing several capabilities: 

• Lists can be backed up on a PC, and sent to another server. 

• Lists can be viewed and printed from the PC 

• Lists can be edited or created on the PC and uploaded to the server. 

Playlists are found on the server FTP directory in the lists folder.  They are simple text files with 
the extension .lst.  Below is an example of a playlist as it appears in the GUI and its 
corresponding .lst file: 

 

Playlist Example 

 
#360PLAYLIST 2.0 
#StartTime 13000100 
#Loop 0 
 
"/Public Service Announcement" 
"/Adverts/Commercial" 
"<HOLD>", HOLD 
"/Sitcom",#1@0;10 
"/Movie of the Week",#2@15;1000,#6@1245000;400 
"/Documentary", SKIP 
"/Still Frame" 
"/Still Frame 2", frames=150 
 

Each line of the example appears with its explanation below: 
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#360PLAYLIST 2.0  
Header line, this must always be present exactly as shown. 

#StartTime 13000100 
This is the Start Time in military format, hours, minutes, seconds and frames, without leading 
zeros. This value shows 13:00:01 or 1 minute past 1 pm. The default is 0 which is 12 midnight.  
While frames are present in this value, the last two digits should always be “00” when entering 
any value except 0. 

#Loop 0 
This is the default, a looping list would show “#Loop 1”. 

"/Public Service Announcement" 
This is the first clip in the list, named Public Service Announcement.  It is enclosed in quotes, 
and preceded by a forward slash ( / ) which denotes that the clip is found in the root directory 
(i.e. it is not in a subfolder). 

"/Adverts/Commercial" 
This is the second clip, named Commercial.  It is in the Adverts subfolder.  Further levels of 
subfolder nesting would be shown as “/Folder/Subfolder/ClipName”. 

"<HOLD>", HOLD 
This is a Hold event.  The list will stop until it is restarted by command. 

"/Sitcom",#1@0;10 
This clip has a GPI Output event associated with it, in this case Output #1, at an offset of 1 
frame, for a duration of 10 frames.  Similar to Start Time values, GPI Output Offsets and 
Durations are represented as hours, minutes, seconds and frames without leading zeros. The 
format is: 

,#GPIOutputNumber@Offset;Duration 

"/Movie of the Week",#2@15;1000,#6@1245015;400 
This clip has two GPI Output events, Output #2 @ 15 frames offset ; 10 seconds duration, and 
#6@1 hour 24 minutes 50 seconds 15 frames offset; 4 seconds duration. 

"/Documentary", SKIP 
This clip is skipped, this is programmed in the GUI by unchecking the check box for the event. 

"/Still Frame" 
Still frames appear the same as standard motion clips; the name of this clip is Still Frame. 

"/Still Frame 2", frames=150 
 

This still frame has a duration programmed.  Unlike other time values, durations are frame 
counts. At 59.94 Hz, this is a 5 second duration.  While it is possible to add a duration to a 
motion clip, this is not recommended.  It is only allowed to specify fewer frames than the 
edited length of the clip (Mark In to Mark Out).  You cannot make the clip “loop” by specifying 
a longer duration. 

When opening Playlist files in a text editor, you may have to change the file type to “All Files” 
to be able to see files with the .lst extension.  
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Some text editors, such as Notepad, do not display each line separately.  Word and Wordpad 
perform correctly because they accept files that have only Line Feeds (LF) at the ends of lines.  
The server will accept modified or externally created files with only LF or with both LF and 
Carriage Return (CR) at line endings.  Do not use only CR without LF. 

A list can be edited by: 

• Changing the name of a clip: Clip names are case sensitive.  Any clip name that does not 
match an existing clip will be reported as MISSING when the list is loaded on the server.  
This also applies to the name of a subfolder. 

• Adding or deleting an event manually: Any of the available event types can be created. 

• Modifying or adding to existing events:  “, SKIP” “, frames=xx” or GPI Outputs can be 
added. 

• Cutting and pasting the contents of one list into another, or duplicating sections of a list. 

Save the file as a raw text file, and replace the .txt extension with .lst.  File names should be 
limited to 31 characters. 

When transferring .lst files via FTP, always specify Binary mode.  Do not use ASCII or Auto. 
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Appendix E 
As-Run Logging Detail 

To enable As-Run logs, open a Playlist window, select Options, and then click on As-Run 
Logs.  When enabled, a check mark will appear next to the As-Run log label, and files played by a 
playlist will be written to an As-Run log. Clips played in a transport window do not get written to 
an as-run log.  

As-Run logs are available only through FTP downloads; they cannot be viewed or printed from 
the server itself.  After logging into the server, select the ASRUN folder.  All logs are stored in this 
location, and have the extension “.arl”. 

As-Run Naming Convention 
The Naming convention for as-Run logs is as follows:  mmdd.c_xxxx.n.arl 

mm   month ( 01 through 12 ) 
dd     Day     ( 01 through 31 ) 
c      Channel ( 1 through 3 ) 
xxxx  Name of Playlist 
n Instance Count 
arl file extension 

Sample As-Run Log 
IS-76152 as-run (Ch2:KQRS) Engr Wed Feb 02, 2009 [Wednesday PM]          Pg 1 

   1  10:54:40   00:00:05:00   KRBE ID - Legal          PLAYED OK 
   2  10:54:45   00:00:30:00   Cellular One – Talk Time     PLAYED OK 
   3  10:55:15   00:00:30:00   Burger Stop – 2 for 1           PLAYED OK 
   4  10:55:45   00:00:15:00   Promo – Friends - Today   PLAYED OK 
   5  10:56:00   00:00:30:00   Bank of America – Gold Years      PLAYED OK 
   6  10:56:30   00:07:18:05   RICKI WEDNESDAY – SEG 1      PLAYED OK 
 
Periodically, old logs should be deleted using the Delete command on your FTP client 
software. 
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As-Run Log Page Header 
This section describes the format of the first line (page header): 

IS-76152 as-run (Ch2:KQRS) Engr Wed Feb 02, 2009 [Wednesday PM]          Pg 1 
IS-76152:  IS-XXXXX, where XXXXX is the unique machine ID as shown in Help>About>Unit ID. 

as-run (Ch2:KQRS):  ChX is the channel number and KQRS is the name of the specific channel, as 
defined in the Configuration System window. 

Engr:  The name of the server, as defined in the Configuration System window. 

Wed Mar 30, 2009:  The base date to which clip times are referenced. 

[Wednesday PM]:  The name of the playlist 

Pg 1:  The page number of the printout.  
 

As-Run Log Body 
This section describes the format of the body of an As-Run log: 
2  10:54:45   00:00:30:00   Cellular One – Talk Time      PLAYED OK 

 
2:  The line number (order) of the clip as it appears in the playlist. The same clip could have 

multiple numbers as files are added or deleted. 

10:54:45  The time at which the clip was played in HH:MM:SS, on a 24-hour clock. 

00:00:30:00  The length of the clip in HH:MM:SS.FF, on a 24-hour clock. 

Cellular One – Talk Time:  The name of the clip. 

PLAYED OK:  The status of the played clip.   

 

Other possible status conditions are: 

CLIPPED - Less than the full length played.  

SKIPPED – The clip was skipped over because it was deselected (unchecked) or playback was 
order was modified by CUE or JUMP 

STOPPED – The clip was stopped during playout.   
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Appendix F 

Mechanical Drawing 

 

Figure 32: Dimensional Drawing 
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